Contents

Preface ............................................................................................................. 1
Related Documentation ................................................................................ 1
Customer Support .......................................................................................... 1

1 Release Notes ............................................................................................... 3
What’s New in Version 8.2? ........................................................................... 3
Simulation Changes .......................................................................................... 4
  Fixed Cost for Workcenters in Simulation ..................................................... 4
  Guaranteed Service Time ............................................................................ 4
  Demand Seed Value ..................................................................................... 4
  Sourcing Cost in Simulation ........................................................................ 4
  Inbound and Outbound Costs in Inventory Policies ..................................... 4
  Minimum Lot Size ........................................................................................ 5
  Allow Back Orders ....................................................................................... 5
  Simulation Options ....................................................................................... 5
  Simulation Output ........................................................................................ 6
Improved Messaging for Expression Constraints with Missing Requirements ...... 6
 Vehicle Route Optimization Changes ............................................................... 7
  Asset Search Distance ................................................................................. 7
  Time Zone .................................................................................................... 7
  Shipment Weight and Cubic ......................................................................... 7
  Config.csv ................................................................................................... 7
Safety Stock Optimization Changes ................................................................. 7
  Inventory Policy Summary Output Fields .................................................... 7
  Improved Efficiency of Outlier Analysis ...................................................... 8
Cloud Solver Usage .......................................................................................... 8
  Remote Solver Options ................................................................................ 8
    Cloud Solver ............................................................................................. 8
    SupplyChainGuru.com .............................................................................. 8
    Supply Chain Guru 8.1.x Cloud Usage ......................................................... 9
    Supply Chain Guru 8.2 Cloud Usage ........................................................ 9
    SupplyChainGuru.com Account ................................................................. 9
Model Upload to SupplyChainGuru.com .......................................................... 11
Support for SQL Server 2014 Express ............................................................... 11
Issues Resolved in Version 8.2 ........................................................................ 12
  Network Optimization ............................................................................... 12
  Simulation ................................................................................................. 12
2 Known Issues

Installation ....................................................................................17
Models and Projects ........................................................................18
Input Pipes ....................................................................................19
Greenfield Analysis .......................................................................19
Network Optimization ....................................................................20
Simulation .....................................................................................23
Safety Stock Optimization .............................................................25
Multi-Objective Optimization..........................................................26
Vehicle Route Optimization .............................................................26
Auto Implement Optimized Model ....................................................29
GeoCoding Guru ..........................................................................29
Routing .........................................................................................29
Tables and Grids ..........................................................................29
Charts and Graphs .......................................................................30
Scenarios .......................................................................................30
Import/Export ...............................................................................31
Maps ............................................................................................31
Visual Modeler ..............................................................................32
Tabular Reports ............................................................................32
Product Classification Tool ..............................................................32
Cloud ...........................................................................................32
Localization ...................................................................................33
Help .............................................................................................35

3 Installation ..................................................................................37
System Requirements ....................................................................37
Model Size ..................................................................................39
System Requirement Details .........................................................39
CPU Performance ........................................................................39
Memory Considerations ................................................................39
Disk Speed ..................................................................................40
Operating Systems .......................................................................40
Displays on Laptops and Tablets ....................................................40
User Agent and Host Access ..........................................................40
Prerequisite Software .....................................................................40
Microsoft .NET Framework ..........................................................40
Preface

Welcome to the Supply Chain Guru Release Notes 8.2. Please read through this entire document to ensure you have a full understanding of how to install Supply Chain Guru 8.2 and make use of new and enhanced features.

For information about installing Supply Chain Guru 8.2, refer to “Installing Supply Chain Guru” on page 48.

Related Documentation

The Supply Chain Guru documentation set includes the following documents:

- Supply Chain Guru Release Notes
- Supply Chain Guru User Guide
- Supply Chain Guru Data Dictionary
- Supply Chain Guru Tutorial

Customer Support

Supply Chain Guru users have access to support.llamasoft.com, which acts as a gateway to a vast array of resources, data, tools, and knowledge.
Chapter 1

Release Notes

What’s New in Version 8.2?

There are a number of significant new features and enhancements to existing features in Version 8.2. Refer to the following topics for details about new and enhanced functionality:

- **Simulation Changes**
  - Fixed Cost for Workcenters in Simulation
  - Guaranteed Service Time
  - Demand Seed Value
  - Sourcing Cost in Simulation
  - Inbound and Outbound Costs in Inventory Policies
  - Minimum Lot Size
  - Allow Back Orders
  - Simulation Options
  - Simulation Output

- **Improved Messaging for Expression Constraints with Missing Requirements**

- **Vehicle Route Optimization Changes**
  - Asset Search Distance
  - Time Zone
  - Shipment Weight and Cubic
  - Config.csv

- **Safety Stock Optimization Changes**
  - Inventory Policy Summary Output Fields
  - Improved Efficiency of Outlier Analysis

- **Cloud Solver Usage**

- **Model Upload to SupplyChainGuru.com**

- **Support for SQL Server 2014 Express**
Simulation Changes

Fixed Cost for Workcenters in Simulation

Three new columns have been added to the Simulation Output Work Center Summary table:

- Throughput Level
- Throughput Basis
- Fixed Operating Cost

The fixed cost is also reflected in the Simulation Network Summary as part of the Total Fixed Operating Cost.

Guaranteed Service Time

An additional column has been added to Sourcing Policies called Guaranteed Service Time.

The Guaranteed Service Time is used to determine if the Source site can supply the Product to the Destination within this time frame. If this is not possible, the order is considered to have been missed and the Fill Rate may decrease. The Guaranteed Service Time is in terms of days. It is used to simulate the results of Safety Stock Optimization for BOM components.

Demand Seed Value

The Demand table now includes an integer field called Seed. You can use this field to control the ordering pattern used for demand. For example, if you have customers that should follow the same ordering pattern, you can populate the Seed value with the same value in the demand records for these customers. By default, this field is not populated and the seed value is determined based on the order in which the demand is processed. As a result, it is somewhat random in its results.

Sourcing Cost in Simulation

The existing Sourcing Cost in the Sourcing Policies table is used to represent the sourcing cost per unit and has been renamed to Sourcing Unit Cost. A new field, Sourcing Order Cost, has been added to the Sourcing Policies table to represent the per order sourcing cost.

Inbound and Outbound Costs in Inventory Policies

Two fields in the Inventory Policies table have been renamed and four new fields have been added to reflect inbound and output costs:

<table>
<thead>
<tr>
<th>Field</th>
<th>Change</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound Shipment Unit Cost</td>
<td>Renamed from Inbound Cost</td>
<td>Enter the activity cost of handling and moving one unit of this product from the receiving dock into inventory.</td>
</tr>
<tr>
<td>Output Shipment Unit Cost</td>
<td>Renamed from Outbound Cost</td>
<td>The activity cost of removing one unit of this product from inventory to the shipping dock.</td>
</tr>
</tbody>
</table>
Minimum Lot Size

A new Minimum Lot Size field has been added to the Processes table. Use this field to enforce a minimum batch size in the process. The existing Lot Size field serves as a capacity (breaking quantities into pieces if necessary). The new Minimum Lot Size enables you to specify the minimum number of units that must be produced at a time. It prevents a process step from producing if this threshold is not met. For example, if you have an order for 25 units coming to a process that has a minimum lot size of 50, the process will produce a lot of 50.

Allow Back Orders

The Allow Back Orders flag in the Sourcing Policies table is now enforced regardless of the site type. This permits you to set this flag for existing facility to existing facility moves.

Simulation Options

The Time Series tab has been renamed to Detailed Output in Simulation Options. New options on this tab enable you to control which output is populated when Simulation is complete. By default these options are unchecked. In this case, Simulation will still populate the various summary tables, but not the detailed transaction tables controlled by these options. This will improve the overall run time of Simulation.

The Transaction Data settings are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Change</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound Shipment Cost</td>
<td>New</td>
<td>Enter the activity cost of handling and moving a shipment of this product from the receiving dock into inventory.</td>
</tr>
<tr>
<td>Outbound Shipment Cost</td>
<td>New</td>
<td>The activity cost of removing a shipment of this product from inventory to the shipping dock.</td>
</tr>
<tr>
<td>Consignment Cost</td>
<td>New</td>
<td>The outbound handling cost of a shipment of this product.</td>
</tr>
<tr>
<td>Consignment Unit Cost</td>
<td>New</td>
<td>The outbound handling cost of one unit of this product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Transactions</td>
<td>When this option is checked, the Demand Transactions Simulation Output table is populated when Simulation is complete. When this option is unchecked, no data is populated in the Demand Transactions table.</td>
</tr>
<tr>
<td>Shipment Transactions</td>
<td>When this option is checked, the Shipment Transactions Simulation Output table is populated when Simulation is complete. When this option is unchecked, no data is populated in the Shipment Transactions table.</td>
</tr>
</tbody>
</table>
Chapter 1  Release Notes

Note that the Time Series Statistics options are also not selected by default. If you want to display time series graphs, you must check the required Time Series Statistics option(s).

**Simulation Output**

The output generated by Simulation has been significantly enhanced in Supply Chain Guru 8.2. A number of new output tables have been added and fields have been updated in existing tables.

New tables include:
- Interfacility Shipment Flows
- Customer Shipment Flows
- Bill of Materials Summary
- Customer Summary

and others.

For a complete description of all Simulation Output tables, refer to Simulation Output Tables in the Supply Chain Guru online help.

**Improved Messaging for Expression Constraints with Missing Requirements**

Expression Constraints typically reference standard constraints or records from other tables. In some cases, the data that is referenced is missing. This can occur because of incorrect constraint names and excluded records. Previously, when a model with these missing requirements was solved with Network Optimization, the error returned was
“Index out of range”. The messaging has been improved to provide a better indication of the issue that causes the solve to fail.

**Vehicle Route Optimization Changes**

**Asset Search Distance**

The default value for the Asset Search Distance in the Sites table has been changed to 0 (from 100). This prevents assets from other sites being used unless you deliberately specify a search distance.

**Time Zone**

The Time Zone field in the Sites table now includes a dropdown list with the names of all supported time zones.

**Shipment Weight and Cubic**

The Unit Weight and Unit Cubic fields in the Shipments table have been renamed to Weight and Cubic, respectively. This change is designed to more accurately reflect what these values represent.

**Config.csv**

When you run Vehicle Route Optimization, parameters are written to the parameter.csv file in the <modelname>_TransOptimData folder by default. If you want to override these values, you can create a config.csv file using the same format as parameter.csv. Any parameters defined in config.csv will override the settings in parameter.csv.

**Safety Stock Optimization Changes**

**Inventory Policy Summary Output Fields**

New fields have been added to the Inventory Policy Summary and Inventory Policy Details Optimization Output tables:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excess Safety Stock</td>
<td>This field displays the difference between the Minimum Safety Stock as defined in the Inventory Policies table and the calculated optimal safety stock. Safety Stock is the optimized amount of safety stock you must carry to satisfy the target service level. However, you may want to carry more than the optimized safety stock. In this case, you can input a Minimum Safety Stock that is greater than the optimal safety stock. When the Minimum Safety Stock &gt; optimal safety stock, the difference is reported as Excess Safety Stock.</td>
</tr>
<tr>
<td>Total Safety Stock</td>
<td>This field displays the sum of the Safety Stock and Excess Safety Stock.</td>
</tr>
</tbody>
</table>
**Improved Efficiency of Outlier Analysis**

The analysis of outliers during Demand Analysis has been improved to provide better performance.

**Cloud Solver Usage**

You can use remote design engines to solve models from your Supply Chain Guru client application. The Cloud Solver options available to you are different depending on whether you are using Supply Chain Guru 8.1.x or Supply Chain Guru 8.2 as described in the sections that follow.

**Remote Solver Options**

**Cloud Solver**

Supply Chain Guru users have the ability to solve models on remote solvers. For example, when using Network Optimization, you select the Cloud Solver option in the Run Optimization window:

In this cloud workflow, models are uploaded to the Cloud, and solved on one of the remote design engines. The results are then downloaded to the Supply Chain Guru client computer where you can import them into the model database.

Once the model data has been uploaded to the Cloud Solver, you have the option to launch SupplyChainGuru.com:

Click the “Click here to open SupplyChainGuru.com” link to access SupplyChainGuru.com in a browser window, or click OK to close the message box. If you are accessing SupplyChainGuru.com, you will be prompted to provide your log in credentials.

**SupplyChainGuru.com**

For Supply Chain Guru 8.2 users, when solving on the cloud as described above in Cloud Solver, models will be sent to SupplyChainGuru.com. The SupplyChainGuru.com web site also provides a full interface to create, edit, solve, analyze and share Supply Chain Guru models. In addition, the SupplyChainGuru.com workflow also supports uploading a model from the Supply Chain Guru desktop client. Once a model is uploaded from the desktop
client, you can share the model with LLamasoft Support and other users, and work with the model on the SupplyChainGuru.com web site.

**Supply Chain Guru 8.1.x Cloud Usage**

To use Supply Chain Guru 8.1.x to solve on the Cloud, the URL is:

http://k2-scg81.supplychainguru.com

For those people who are running Supply Chain Guru 8.1.x (8.1, 8.1.1, 8.1.2 or 8.1.3), you can continue to solve models on the 8.1 K2 Cloud (http://k2-scg81.supplychainguru.com). When solving on the 8.1 Cloud, the following design engine options are available:

- Network Optimization
- Safety Stock Optimization
- Greenfield Analysis
- Infeasibility Diagnosis
- Simulation

**Supply Chain Guru 8.2 Cloud Usage**

To use Supply Chain Guru 8.2.x to solve on the Cloud, the URL is:

https://www.supplychainguru.com

Supply Chain Guru 8.2 users will be able to solve models on SupplyChainGuru.com using the standard cloud workflow. Models are sent to SupplyChainGuru.com, which manages the design engines and provides the results back to the desktop client. When solving on SupplyChainGuru.com, the following design engine options are available:

- Network Optimization
- Safety Stock Optimization
- Greenfield Analysis
- Infeasibility Diagnosis
- Simulation

Within Supply Chain Guru, the Cloud URL on the Cloud tab of Application Settings must be set to the SupplyChainGuru.com web address. The credentials must be those for your SupplyChainGuru.com account. With valid SupplyChainGuru.com credentials and the appropriate level of account, you can solve models using the cloud workflow and upload models from Supply Chain Guru to SupplyChainGuru.com. Refer to **SupplyChainGuru.com Account** for additional information.

**SupplyChainGuru.com Account**

In order to continue to use the cloud workflow with Supply Chain Guru 8.2, you will need an account on SupplyChainGuru.com. This account is separate from the existing Support account that provides access to the LLamasoft Support web site.
You can self-register for a SupplyChainGuru.com account from the login page on SupplyChainGuru.com:

![SupplyChainGuru.com login page]

You will be asked to provide information including your name, company, position and email address to register.

If you currently have a Supply Chain Guru desktop license, you will be provided with a Demo user account when you self-register on SupplyChainGuru.com. There are two types of Demo accounts:

- A basic Demo account enables you to view pre-loaded demo models and navigate the entire site. This license does not allow you to solve models with any of the design engines.
- If you have a Demo account with Support, in addition to viewing pre-loaded models and navigating the site, you can also upload models to SupplyChainGuru.com to share with LLamasoft Support or with other users. This type of account does not allow you to solve models.

In order to use SupplyChainGuru.com to solve models and for the cloud workflow from Supply Chain Guru, you will need to have this account elevated to a Designer account.
Please contact LLamasoft Support for additional information about conditions of usage and to upgrade your SupplyChainGuru.com account.

Model Upload to SupplyChainGuru.com

You can now upload models directly from Supply Chain Guru to the new SupplyChainGuru.com. Once the model has been uploaded, you can share it with LLamasoft Support or other SupplyChainGuru.com users. You can also work with it using the web-based interface on SupplyChainGuru.com.

To upload a model to SupplyChainGuru.com:
1. In Supply Chain Guru, open the model that you want to upload. Make sure it is selected in the Project Navigator.
2. Select Home > Upload.

SupplyChainGuru.com requires SQL Server 2014. If your current SQL Server instance is not a SQL Server 2014 instance, you will receive a warning:

![SQL Server Version Warning]

LLamasoft recommends that you set your Local Server Instance to a SQL Server 2014 instance on the SQL Server tab of Application Settings before uploading to SupplyChainGuru.com.

3. You see the Cloud Model Upload window. The current model name is the default name for the model on SupplyChainGuru.com.
4. If needed, edit the model name, then click Upload Model. The model is uploaded and made available on SupplyChainGuru.com.
5. Once you upload a model, the Model Queue tab of the Solver Monitor, the model will have a Run Type of “Model Upload” and you will see the status of your model. When the Status is “Model Uploaded”, it is available for use on SupplyChainGuru.com.

Support for SQL Server 2014 Express


During the installation of Supply Chain Guru, SQL Server 2014 Express is installed. If you have an existing version of SQL Server, the new installation will be installed in a side-by-side instance.

Note: If you have multiple SQL Server instances on your system, you can use the Local Server Instance setting on the SQL Server tab in Application Settings to control which instance Supply Chain Guru will use. If you change the Local Server Instance, it is recommended that you restart Supply Chain Guru. For example, if
When you change the instance from SQL Server 2014 to SQL Server 2008, Supply Chain Guru will not recognize the older instance until you restart.

Once you open a model with the SQL Server 2014 instance selected, the model has been updated to SQL Server 2014 format and can not be opened with an earlier SQL Server instance.

# Issues Resolved in Version 8.2

## Network Optimization

GCX-5: Distance Req\textit{t} value is not changed when using scenarios with in-memory processing – When running Network Optimization, if scenarios were used to change the Distance Req\textit{t} value on the Service Requirements table, these changes were not being used. The values are now used correctly when the model is solved.

GCX-41: Termination Gap in the Solver Status window not matching gap in Solver – The Solver Status window reported the gap as (Best Solution - Best Bound)/Best Bound. The denominator used by the solver is actually Best Solution. The Solver Status window now reports the gap as (Best Solution - Best Bound)/Best Solution.

GCX-95: Linked field in Network Paths or Network Path Summary causes crash when regenerating – If a linked or user-defined field was added to the Network Paths or Network Path Summary table, the application crashed when Generate Network Paths was subsequently run. This has been resolved and the linked and user-defined fields are correctly maintained when Generate Network Paths is re-run.

SCG-1879: Site Name greater than 50 characters causes Network Optimization failure – The Constraint Summary Optimization Output table incorrectly had the Site Name limited to 50 characters. This caused Network Optimization to fail when the model included Site Names longer than 50 characters. The Constraint Summary now supports Site Names up to 100 characters.

## Simulation

BUG-53: Input Pipes on Inventory Policies Outbound Shipment Cost field do not work correctly in Simulation if unexpanded - The Product Summary reports 0 cost. This has been resolved and input pipes on Inbound Shipment Unit Cost and Outbound Shipment Unit Cost both work correctly in-memory and with manual expansion.

BUG-309: The SplitByRatio Transportation Policy is not working correctly when Ship To field is populated – This case is a model where the customer was sourced directly by the manufacturer and Transportation Policies used the Ship To field to specify the DCs on the lanes. If the ByProbability Mode Rule was used, the splits in the Simulation output were correct. If SplitByRatio was used, there were no Network Flows generated. Both Mode Rules are now supported correctly in the Network Flows table.

BUG-319: Detailed Status History is cleared when Simulation completes – While Simulation is running, information is written to the Detailed Status History on the Simulation Status window. As soon as the Simulation was complete and all output had been written to the output tables, the information was cleared. The status information is now maintained at the completion of Simulation.

BUG-335: Transportation Policies with no Product defined do not behave correctly – If Transportation Policies do not have a Product defined, they should apply to all products.
However, the policies were not being to any product. When no Product is defined in Transportation Policies, they are now correctly applied to all products.

BUG-363: The application crashes if a non-integer value is entered for the Number of Replications Simulation option – In Simulation Options, on the General tab, if you entered a non-integer value (such as 2.5) for the Number of Replications option, Supply Chain Guru crashed. Non-integer values are not allowed, so there is no failure.

GCX-23: Dynamic Input Pipe created on a SQL Server model causes a crash – If you created a simulation Dynamic Input Pipe on a SQL Server model, Supply Chain Guru crashed. Dynamic input pipes now work successfully on both Access and SQL Server models.

GCX-66: Script Editor crash when entering only a period in the script body – If you opened the Script Editor with a new script and entered only a period character (.), the Script Editor crashed. These types of entries no longer cause a crash.

SIM-49: SimServer shuts down when Asset & Inventory Constraint uses Customer site – This is a case where an Asset & Inventory Constraint used a Customer Site (these constraints are meant to be used with non-Customer sites). When Simulation was run on this model, the SimServer executable exited with no warning to the user. Use of a Customer site is not actually correct for this table. When the constraint used an Existing Facility, it ran as expected. SimServer now no longer exits, even if a Customer Site is used in an Asset & Inventory Constraint.

SIM-94: Nested script call can cause a crash – Some nested script call structures can result in a crash. For example, there may be cases where an order queue is created, but is cleared before a review, causing problems with the script. This nested condition has been resolved.

**Vehicle Route Optimization**

BUG-295: When a value is entered in the Transit Override Cost field, Vehicle Route Optimization fails – When Cost is populated on the Transit Override table, Vehicle Route Optimization fails with a cast error. The Cost field is now correctly supported in the Transit Override table.

SCG-1589: Temporary file creation failed error on SQL Server models – Occasionally, running Vehicle Route Optimization on a SQL Server model can result in a “Temporary file creation failed” error. This error has been resolved.

VRP-305: Cubic Fill Level and Qty Fill Level may cause error -7 for Interleaved Optimization – This only occurred when the Asset Optimization option was selected and the Key Unit of Measure was set to Qty. The error no longer occurs.

VRP-339: Periodic Optimization may create a schedule that violates Asset constraints – In a specific model, the schedule created by Periodic Optimization violated constraints and resulted in extra visits. The condition causing this violation has been resolved.

VRP-367: Shipment x Asset (Force) Relationship Constraint may be violated with Asset Optimization – In some cases, a Shipment x Asset Relationship Constraint was violated due the initial combination of Shipments in the Vehicle Route Optimization. The condition causing this violation has been resolved.

VRP-377: PVRP Delivered Shipments are not written when Periodic Demand Distribution is set to Even – If you set the Demand Distribution option to “Even” on the Periodic Optimization tab of VRO Options, the PVRP Delivered Shipments were not being populated. This output table is populated regardless of which setting you use for the Demand Distribution option.
VRP-433: Use of Per Reposition Distance Cost – In Backhaul and Interleaved Optimization problems, the Per Reposition Distance Cost was not being used as expected. This value from the Rate table is now used for those segments where the asset is empty, with the exception of inbound Standard VRP and Asset Optimization problems.

**Note:** For inbound Standard VRP and Asset Optimization problems, this cost is currently being applied to the segment from the last pickup to the delivery at the pool site.

### Safety Stock Optimization

**BUG-17:** Safety Stock Cost is not correct when using a 5 day work week – If the Work Week option was set to 5 Days, the Safety Stock Cost in the Inventory Policy Summary table was incorrectly based on a 7 day work week. The Safety Stock Cost is now based on the correct Work Week setting.

**IOS-241:** Errors with Type 3 Service when using Negative Binomial Distribution – The Type 3 Service was always being reported as 0 when using a Negative Binomial Distribution. This type of distribution now uses a continuous gamma distribution to prevent errors.

**IOS-242:** Smooth Demand Class reported as Erratic – In some models, smooth demand was being reported as erratic. This has been corrected to report the correct Demand Class.

**IOS-243:** Reorder Point sometimes less than lead time demand mean or negative – In some cases, the reorder point was calculated as less than the lead time demand mean. When this happens, the reorder point will now be set to the lead time demand mean.

**IOS-244:** Adding constraints causes the cost function to be less smooth – When constraints were added, the cost function became less smooth, which could be an issue in the LP formulation. The cost function has been smoothed in these cases.

**IOS-245:** Large Minimum Safety Stock may cause infeasibility – If the Minimum Safety Stock is greater than the quantity required to cover the maximum lead time, the model may be infeasible. An internal penalty is now associated with the difference between Minimum Safety Stock and the optimized value. The difference between the Minimum Safety Stock and optimized value is reported in the Excess Safety Stock field in the Inventory Policy Summary and Inventory Policy Details Optimization Output tables.

**IOS-246:** Safety Stock in the Inventory Policy Summary table not always populated correctly – When the Minimum Safety Stock is set, if the actual calculated Safety Stock is more that Minimum Safety Stock, this is not evident in the Inventory Policy Summary table. Two new fields have been added to reflect this condition: Excess Safety Stock and Total Safety Stock.

**IOS-248:** Extremely slow customer demand when propagated by Demand Quantity could cause infeasibility – When using Demand Quantity as the propagation method, extremely slow customer demand could become demand of a different class (not extremely slow) at the facility. Extremely slow customer demand is ignored, so this caused an infeasibility because the Safety Stock was not being optimized for the facility. The demand is now checked at the facility to resolve this issue.

### Maps

**GCX-6:** Changing Start or End color with no Shaded Area breaks displayed caused crash – If you added a Shaded Area Layer and no Class Breaks were displayed, changing the Start color or End color can cause Supply Chain Guru to crash. You can now access the start and end colors regardless of whether shaded are breaks are displayed or not.
GCX-44: Custom Filters not working for Shaded Areas and other layers with SSO output tables – When Custom Filters were defined for Inventory Policy Summary, Customer Demand Profile, and Facility Demand Profile tables, these were not respected when selected for layers including Site and Shaded Areas. The filters now work as expected.

GCX-76: Product Groups are not displaying on the Map View for Flow Layers – On SimulationFlow and OptimizationFlow layers on the map, when a Product Group was selected in the Product filter, no flows were displayed. The correct flows based on the selected Product Group are now displayed.

**Tables and Grids**

BUG-243: Date formats not available for Date Fields when Column Formatting selected from column header – If you selected Column Formatting when on the column header for a date field, the date formats were not available. The date formats are now available for date fields when using Column Formatting.

GCX-17: Fields are of insufficient width – The following fields were defined with an insufficient width: Inventory Turns in the Inventory Policies table and Resource in the Processes table. These have both been updated to support 100 character values.

GCX-69: Open/Close Relations table has fields of insufficient width – The If Site Name, If Work Center Name, Then Site Name and Then Work Center Name fields allowed values of only 50 characters. Site and Work Center Names can be up to 100 characters. These fields in the Open/Close Relations table now support 100 character values.

GCX-98: Application crashes when Totals footer is toggled on with large values – In some SQL Server models, when total values in Optimization Output tables were very large, toggling on the totals footer could result in a crash. This has been resolved and both SQL Server and Access models can successfully display the totals footer.

SCG-583: Sorting on the Notes field causes records not to display temporarily in SQL Server models – In a SQL Server model, if you sorted on the Notes field in any table, when you closed and reopened the table, the records were no longer displayed. This condition no longer occurs.

**Input Pipes**

GCX-121: Crash if input pipe is created using a data source with a special character in the name – If you create a data source with a special character in the name, such as DC'sWarehouseRates, when you attempt to create an input pipe that references this data source, Supply Chain Guru may crash.

**Graphs**

GCX-3: Simulation Summary Graph causes crash if more than one replication is generated – If Simulation results included more than one replication, opening the Summary Graph would cause a crash. The graph is now displayed with the results from the first replication.

**Localization**

GCX-62: Column update on numeric fields fails when value includes a comma as the decimal character – If you tried to perform a column update on a numeric field, it failed if the value to be used for the update used the comma as the decimal, such as 10,4. Column update now works correctly when the value includes a comma as the decimal character.
Licensing
GCX-102: Message when all roaming licenses are in use is incorrect – The message displayed when all available roaming licenses are in use and another user tries to start roaming was not stated correctly. The message has been corrected.
Chapter 2

Known Issues

LLamasoft is aware of the following issues that all users should be aware of. In some cases, a workaround to the issue has been provided.

Installation

- Set Bing Key link on 32-bit systems – During the installation process the ArcGIS Engine Runtime is updated to version 10.0.4400. In order to allow Supply Chain Guru to display Bing basemaps, you must enter your Bing Key in an ArcGIS utility. On machines with 32-bit operating systems, the program menu option for Set Bing Key does not work.
  
  Workaround: In File Explorer, navigate to C:\Program Files\ArcGIS\Engine10.0\bin. Run the SetBingKey.exe program, enter your Bing Key and click OK.

- Demo Models are not installed when upgrading from a previous version of Supply Chain Guru – If you are upgrading to version 8.2 from a previous version of Supply Chain Guru, the Demo Models are not being installed in the C:\Users\<UserName>\Documents\LLamasoft folder.
  
  Workaround: Uninstall your existing version of Supply Chain Guru before installing version 8.2.

- LicenseMaint.exe is not correctly displaying Roaming buttons – If you have started roaming through the Supply Chain Guru user interface, the LicenseMaint.exe program is not displaying the Stop Roaming button. Instead, it displays Start Roaming.
  
  Workaround: Use the Start Roaming and Stop Roaming options on the About Guru form in the Supply Chain Guru user interface.

- Installation – There may be an issue with the installation program shortcut when a non-Administrator attempts to install Supply Chain Guru over an older version of Supply Chain Guru that was installed using a different account. When this occurs, and the non-Administrator user double-clicks on the Supply Chain Guru desktop shortcut, you see the error “The feature you are trying to use is on a network resource that is unavailable.”
  
  Workaround: Delete the desktop shortcut. Create a new shortcut that points to SCGuru.exe in the Supply Chain Guru installation folder (such as C:\Program Files (x86)\Supply Chain Guru).

- SQL Server with Supply Chain Guru – In order for Supply Chain Guru to work correctly with SQL Server models, you must have ‘Full control’ permissions to the Basic Supply Chain Database.mdf and Basic Supply Chain Database_log.ldf files in the
Supply Chain Guru installation folder. You can set these permissions by right-clicking on the file and selecting Properties. Use the Security tab to set the Permissions for the Users group. This group should have ‘Full control’ set to Allow.

- Previous Installation – In some cases, the Supply Chain Guru installation program may report that another copy of Supply Chain Guru has been found on the machine, even if there is currently no other version of Supply Chain Guru. This warning can be ignored.

- BUG-123: Installer is putting language database files in the Program Files folder – The installer is posting an extra copy of the language database files (Language_Chinese.mdb and Language_Spanish.mdb) to the Program Files (x86) folder on 64-bit systems and in the Program Files folder on 32-bit systems. These are also deployed to the Supply Chain Guru installation folder so it is not causing an issue with Supply Chain Guru.

- BUG-441: Error Log Processing is not working – If you have enabled “Use Web Service to Send Error Log Files” on the Application Settings Web Services tab, error logs will not be sent automatically to LLamasoft.

- SCG-1932: Error reported when using Remove All Licenses using the LicenseMaint.exe program – If you use the Remove All Licenses option in the LicenseMaint.exe program, an error is displayed.

### Models and Projects

- BUG-54: Changes to Project Documents are not detected when opening a new project – When making a change to Project Documents, these are not detected as project changes. If you subsequently open an alternate project, you are not warned to save the project and these changes are lost.

- BUG-100: SQL Server model conversion - Converting a model from SQL Server to Access format indicates the wrong number of rows copied for some tables, even though the correct number is actually copied.

- BUG-128: Excluded products used in Product Substitution groups are not removed during expansion – If a product is used in a Product Substitution group and the product itself is excluded, this product is still in the expanded version of the model.

- BUG-234: A new project can be opened while Vehicle Route Optimization is running – When running a Vehicle Route Optimization, if you select File > New Project, you are warned that Optimization is running and you cannot close the Vehicle Route Optimization window at this time. However, the current project is still closed. When you then re-open the project, there is a warning that the model needs to be recovered due to improper program termination.

- BUG-327: Removing a SQL Server model from project does not detach the model database – If you remove a SQL Server model from a project, it is not automatically detached.

  Workaround: Run the SQLServerConsole.exe application in the Supply Chain Guru installation folder, select the model name and click Detach.

- SCG-1317: Multi-Period Transportation Policy records do not support separate Mode in Access models – In an Access model, you cannot create two Multi-Period Transportation Policy records that differ by Mode. For example:

  Period_001 -> DC_1 -> CZ -> Product_1 -> Customer Delivery
  Period_001 -> DC_1 -> CZ -> Product_1 -> Expedited

  Workaround: Convert the model to SQL Server.
Input Pipes

- **BUG-50**: The "(Input Pipe)" prefix is not added to all fields that can accept an input pipe – This is a display issue only. The input pipe will still function correctly. For example, the following fields in the Transportation Policies table will not show the prefix: Transport Time, Cost, Average Cost, Distance, and Return Trip Time.

- **BUG-159**: Input Pipes with null values may be treated differently with in-memory vs manual expansion – If mapped input pipe records have null values for the field to be populated (such as Average Cost), and the default when the input pipe does not match is INF, manual expansion excludes these records. In-memory expansion includes them in the model input files.

- **BUG-194**: Deleting an unused Data Source deletes an internal table in another Data Source – In this case, the model has two data sources: an internal table that is being used in an input pipe and a second one based on an Excel spreadsheet that is not in use. Note that both data sources use the same Table/Sheet name. Deleting the Excel-based data source actually deletes the internal table that is used by the other data source.

- **BUG-390**: Model fails to generate input files due to extremely large CSV file input pipe – In a case there a model uses a CSV file with over 11 million rows, Network Optimization fails trying to generate the input files.

Greenfield Analysis

- **BUG-13**: Greenfield Analysis failure when Sites are not GeoCoded – If Sites have Latitude and Longitude values of 0, Greenfield Analysis can fail. Workaround: GeoCode all Sites prior to running Greenfield Analysis.

- **BUG-85**: Greenfield Analysis with Clustering fails if Site Name has ')' character – If a Site Name in the model contains the right parenthesis ')' character and you enable the Cluster Customer option, Greenfield Analysis fails.

- **BUG-101**: Greenfield Analysis - Greenfield Build Input Files option can be un-checked after running Network Optimization, leading to an error. Workaround: Do not uncheck the Build Input Files option when running Greenfield Analysis after Network Optimization.

- **BUG-176**: Greenfield Analysis fails when Site Names contain trailing spaces – If any of the Site Name values used in Greenfield Analysis have trailing spaces (such as "Site_01 "), Greenfield Analysis may fail.

- **BUG-285**: Greenfield Analysis with clustering fails when Site Names contain square brackets – If any of the Site Name values used in Greenfield Analysis have square brackets (such as “Site_[01]“), and you are using the “Cluster customers within” option, Greenfield Analysis fails to write input files.

- **SCG-2249**: Greenfield Analysis output is cleared when Network Optimization is run – If you already have Greenfield Analysis output populated for a scenario and you run Network Optimization on the same scenario, the Greenfield Output is cleared during the Network Optimization process.

Network Optimization

- **BUG-41**: Avg Ship Weight is incorrect for some records in unexpanded model – With a specific model, the Avg Ship Weight for several records is different in the unexpanded model than in the expanded version.
Known Issues

- **BUG-68**: Network Paths are not always generating the highest level values – For a model where there are multiple paths from an initial source to final destination that pass through a varying number of nodes, the highest level values may not be generated. For example, if one path passes through 3 nodes before reaching the customer and another passes through 4 nodes, only 3 levels are generated in the Network Paths.

- **BUG-69**: Production costs are not correctly reflecting multiple BOMs on a Make policy – This is a case where two or more Sourcing Policies that use “Make (BOM - Probability)” in a split. Each of the Sourcing Policies has a different Avg Unit Cost value. When the model is optimized, the Avg Unit Cost for the last “Make (BOM - Probability)” Sourcing Policy defined is used for all.

- **BUG-102**: Verify Model with multiple policies for the same product-site combination - Verify Model may generate an error when excluded policies are present in cases where there are several policies for the same product-site combination.

- **BUG-103**: Optimization fails while creating a file when file path is close to max length – When the file path to the model project is greater than 240 characters, Optimization fails.

- **BUG-113**: Book Value calculation does not seem to be working correctly – The specification for this feature indicates that Book Value can be entered both in whole number format and in shorthand format:
  
  For example, `<50000|10000>` would be read just the same as `<50K|10K>`

  Supply Chain Guru currently only accepts the shorthand version (`<50K|10K>`).

  Workaround: Enter the Book Value using K for thousands and M for millions.

- **BUG-115**: Interfacility Flows are not generated if the model contains Shelf Life values and has Bundle All Customer Demand option selected – If a model has Shelf Life populated for a product and the Bundle All Customer Demand option is selected on the Constraints tab of Optimization Options, Interfacility Flows for that product are not generated.

- **BUG-125**: Transportation Asset Summary reporting issues – In a specific model, when more than one asset is included, the Number of Trips for each of the assets is extremely large (46105 and 23360).

- **BUG-126**: Product Flow Optimization fails with a file not found error – During Product Flow Optimization, Supply Chain Guru is looking in the wrong folder for a number of the generated files.

  Workaround: If your products are not structurally linked using a BOM, you can use Decomposition with Product as the Type to generate results comparable to Product Flow Optimization.

- **BUG-133**: Gross capacity is violated when Yield is used – If the Yield forces production of a product to be greater than a work center capacity, this capacity may be violated in order to meet the demand.

- **BUG-134**: Products used in Product Substitution are not reflected in the Inventory Optimization Output table – When a product is used in a Product Substitution group, the regular product is reflected in the Inventory output table, but the substitution product is not. It is reflected in the Productions output table.

- **BUG-135**: Levels not always written out with Generate Network Paths – In some cases where there are a large number of levels within the network and multiple paths to satisfy demand, Generate Network Paths may not write out the final levels. In this case, the manufacturing site is not represented in the network path.
- BUG-143: The Average Cost cannot be set to 0 in subsequent periods using Transportation Policies Multi-Period – When trying to set the Average Cost to 0 in Transportation Policies Multi-Period, Supply Chain Guru actually uses the value from the non-multi-period record.

- BUG-160: Constraint Type in Constraint Summary table is populated with Site Name – When Open/Close Relations are included in Network Optimization, the Set Name from the "If Site Name" field in Open/Close Relations is populating the Constraint Type field in Constraint Summary Optimization Output.

- BUG-164: Site-based Carbon Cost is not reflected in Facility Summary cost – When a site-based Carbon Cost is defined, the Facility Summary shows a Total CO2 value, but there is no associated Total CO2 Cost. The cost appears to be accounted for in the Network Summary.

- BUG-166: Depreciation does not reflect the Period Length – When optimizing models where the periods are of varying length, the Financial Summary table shows the same Depreciation taken for each period, regardless of the length of the period.

- BUG-167: Optimized Units for Transportation Assets not correct – In a specific case, the value calculated for Optimized Units in the Transportation Asset Summary table is not correct.

- BUG-177: Fixed Operating Cap,Cost of <0,0> is not written for Sites Multi-Period – In the Sites Multi-Period table, if you define the Fixed Operating Cost as <0,0> it is not written to the Sites.dat file and, therefore, not used. A value of 0 is written out. If the step function <a,b> is written with anything other than 0 for b, it is also written correctly to the Sites.dat file.

- BUG-214: Generate Network Paths not always successful with SQL models – In specific cases, Generate Network Paths fails on a SQL Server model, but succeeds when the model is converted to Access.

- BUG-220: Network Path generation does not calculate revenue data correctly – When there is revenue data generated in an NO run (flow units X product price), this data is reported in Customer Flows, Network Summary, and Financial Summary. However, Network Path generation is not listing out revenue statistics for each path generated. It shows '0' for every path generated.

- BUG-225: Model with specific Custom Constraints fails – A specific model with Custom Constraints defined fails with a “BIM file creation failed” error. In some cases, Custom Constraints must be updated in order to work correctly with the latest version of Supply Chain Guru.

- BUG-233: Work Resources are not used when on Transportation Policies – When Work Resources are assigned to the Load Resource or the Unload Resource on Transportation Policies, these Work Resources are not used.

- BUG-284: Network Optimization fails when the path to a model contains a number, period and space – If the path to a model is defined with a number, period and space (such as “1. Basic”), Network Optimization will fail with an error about invalid bracketing.

- BUG-296: Pre-build inventory incurred with Max Dwell Time = 0 – In some cases, if you define a Max Dwell Time of 0 on the Inventory Policies table, a site may still incur Pre-build Inventory.

- BUG-298: Verify Model may report incorrect results for BOMs – Verify Model will incorrectly report errors when BOMs have Byproducts or End Products. Incorrect errors are also reported when the Sourcing Policy is set to Make (BOM-Probability) or Make (Single BOM).
- **BUG-311:** Distance Req on Service Requirements can cause model to be infeasible – In a case where a model had two valid Transportation Policies to source a customer demand, if the Service Requirement Distance Req eliminated one of the policies, the model is infeasible, even though the second policy is still valid.

- **BUG-324:** Min Dwell Time with final model period not behaving as expected – In a case where the final period is excluded from the model horizon, production is occurring in what is now the last included period, which appears to violate the Min Dwell Time.

- **BUG-364:** Accumulated Depreciation field in Network Summary is not always populated – In some cases, the Accumulated Depreciation field in Network Summary may not be populated.

- **BUG-373:** Facility Fixed Cost change using a scenario is not reflected in Network Paths – For a model that changes the Facility Fixed Cost through a scenario, the Total Fixed Operating Cost in the Network Summary correctly reflects the update. However, when Generate Network Paths is run, the Facility Fixed Cost field in Network Paths does not reflect the change. Note: The FacilityFixedCost# fields are not currently exposed in the user interface.

- **BUG-379:** Value in Products Multi-Period table is not used when determining Duty Cost – If the Products Multi-Period table has changes to the product Value for various periods, this is not having an impact on the Duty Cost. The Duty Cost always reflects the Value from the Products table.

- **BUG-392:** Financial Summary (and other tables) not applying the Discount Rate (NPV) – Values for costs in the Network Summary, such as Transportation Cost, have the Discount Rate (NPV) from Model Options applied. The Discount Rate (NPV) is not being applied in the Financial Summary, Customer Flows and Interfacility Flows output tables.

- **SCG-401:** Network Paths may not include all Production Costs in multi-period model – In cases where the demand that uses specific production is actually in the next period, the Network Path may not include the Production Cost for the period where the production occurred.

- **BUG-410:** Sub-scenarios fail when a scenario is used to change the NPV Discount Rate by more than one value – If you create a scenario item to change the NPV Discount Rate by more than one value (resulting in multiple sub-scenarios), these sub-scenarios will fail.

- **SCG-413:** Using a Product Group to replace a Product is not working in memory – If a Scenario is used to substitute a Product Group for individual Product values in Sourcing Policies, the scenario does not have an affect when the model is solved. Note: This type of structural change using a scenario is not recommended. Workaround: Manually expand the model and then run Network Optimization.

- **BUG-434:** Negative Weight is not written out during Sequential Optimization – In the Sequential Objective records, if you define a negative value for the Weight field, it will not write this value to the OBJECTIVES.dat file. Instead, it writes out * indicating that the default value should be used.

- **SCG-1042:** Filters on Model Queue are not working for models sent to K2 Cloud – Models being solved on K2 Cloud are displayed in the Model Queue only if all filters were selected or all filters are de-selected. Individual filters do not work.

- **SCG-1981:** Expression Based Costs are not reflected on Financial Summary – When a model that includes Expression Based Costs is run, the Network Summary reflects the difference in cost as a result of the Expression Based Costs. However, the Financial Summary lists the Total Cost without considering the Expression Based Costs.
Known Issues

- **SCG-2169**: Model fails if Open/Close Relations uses a group set up with “Treat as individuals” – If you create an Open/Close Relations constraint using a group defined as “Treat as individuals”, Network Optimization will fail.
  Workaround: You should set up Open/Close Relations that use groups only defined as “Set” or “Aggregate into Group”.
- Network Optimization - Optimization fails while creating a file when file path to the project is 240 characters or more.

**Simulation**

- **BUG-30**: The Script Editor loses script text when a property is changed and the script is reopened – If you enter text into the script body and save the script, then change one of the script Properties and close and reopen the Script Editor without again saving the script, the text you entered is no longer in the script.
- **BUG-52**: Lognormal Transport Time – In some cases, defining the Transport Time as a Lognormal distribution can result in excessively long transportation times.
- **BUG-58**: Simulation Production Transactions Quantity is not showing rounded values for Discrete products – When a product is specified as Discrete, the Production Transactions table has a Quantity matching the Reorder/Order Up to Qty, regardless of whether the product was Discrete or Continuous. For example, Demand is fractional, such as 10.5. The Inventory Policy Reorder/Order up to Qty value is 10.5. The Network Flows, Site (Throughput), Demand Transactions and Shipment Transactions discrete values of 10 and 11, while the Production Transactions Quantity value is 10.5.
- **BUG-104**: Verify Model in Simulation may result in false positives - For example, Verify Model may report "No sourcing policy for the customer demand" which is not required for simulation if you have a shipment heading to the customer. It may also report "Duplicate Records: There cannot be more than one transportation policy record with the same source site, destination site, product name and mode" which is not always true if you are using transportation policies with Ship To defined.
- **BUG-183**: SimServer process does not always shut down when exiting Supply Chain Guru – On occasion, the SimServer process fails to shut down when you exit Supply Chain Guru.
  Workaround: Open the Task Manager and manually close the SimServer.exe or SimServer64.exe process.
- **BUG-198**: The Model Queue on the Solver Monitor form shows 1/1/1 as the “Added On” date – When using Simulation, regardless of the actual date, the Model Queue shows the “Added On” date as 1/1/1.
- **BUG-278**: Output not correct when date format is non-standard for US region – When the computer setting for date format is set to something non-standard for the specified region, Simulation output may be incorrect. In some cases, data is not read into some of the output tables, such as Demand Transactions. Additionally, date values in populated tables may be incorrect.
- **BUG-303**: Simulation Script compilation may fail when auto-complete is used to build the script – In some cases, using the auto-complete feature when defining a Simulation Script results in an invalid script definition that fails to compile when Simulation is run.
  Workaround: Manually enter the text without the auto-complete feature, or define the script in an external editor and copy into the Script Editor.
• BUG-318: Opening Script Editor can crash if SimServer process is still running – If you have run Simulation and the SimServer process did not successfully close, open the Script Editor can result in a crash.
  Workaround: Before using the Script Editor, check the Windows Task Manager to be sure the SimServer.exe or SimServer64.exe processes are not running.

• BUG-322: Script Editor: Incorrect auto complete for Context.WorkStep – When scripting a Process Routing Rule, Context.WorkStep should give the autocomplete option of WorkCenterName. Instead, it gives WorkCenter.Name which is an invalid identifier.
  Workaround: Manually edit the script to enter the correct context value.

• BUG-323: Script Editor: Incorrect auto complete for Context.ProcessLot.DueDate – When scripting a Process Routing Rule, the auto complete should provide Context.ProcessLot.DueDate. However, it is currently supplying Context.ProcessLot.DateDue.
  Workaround: Manually edit the script to enter the correct context value.

• BUG-371: The MCD writer does not currently write the information required to capture queue logging statistics – Lines are not being written to the MCD file to capture the queue logging statistics.
  Workaround: These lines can be added manually to the file.

• BUG-372: Script Editor does not always compile – In some cases, when running a model that includes a script, the model may fail with an error in BuildLog.txt regarding the failure of the script to compile. This may be due to a formatting issue caused by the auto complete feature in the Script Editor.

• BUG-400: Normal Distribution for Time Between Order does not output to end of horizon – In a case the the Time Between Order on Demand is set to N(1,1) and the Occurrences is set to INF, the Demand Transactions do not continue to the end of the model horizon.

• BUG-402: DOS - Demand does not handle day 0 correctly – In a model with Demand on day 0 (Order Time Formula) and Inventory Policy set to DOS - Demand Based, the values calculated for the Reorder Point and Order Up To Level (these are in days for DOS - Demand Policy do not match the running average as expected for the first 11 days (the DOS window is 10).
  Workaround: Move the model start day one day earlier and then change the order time formula to run from 1 – 30 (instead of 0 - 29) to generate demand on the same timeline as the original model.

• SIM-20: Containers are rounding below Fill Level – When the Cubic Fill Level for an asset is set to 1, the Shipment Transactions may report a Cubic value less than 1.

• SIM-21: Demand Flow Inventory Policy timing is incorrect – In the Shipment Transactions tables, the flows are happening from the MFG to the DC prior to those from the DC to the CZ for each Demand shipment. The Demand Flow policy fills the demand order, then does the replenishment, so the flow from the DC should happen before the flow from the MFG for that amount.

• SIM-95: Assets not respecting Transport Time when they are set to a different base – When assets rebase, the origin and destination latitude and longitude are used to determine distance, then divided by asset speed to decide how long to move. This completely ignores any lanes or other structures that the user has set up.

• SIM-96: Fixed Cost is incorrect if the Capacity Period is set to Period Length – When the Capacity Period on the Sites table is set to Period Length, the value set for the Fixed Cost may be incorrect.
Known Issues

Safety Stock Optimization

- **BUG-4**: Non-Zero Demand CV2 in not working with User Defined Customer Demand Profile – When the User Defined Customer Demand Profile is populated, the Non-Zero Demand CV2 value in the Customer Demand Profile table is displaying 0, rather than the calculated value. This is display issue only and should not affect the results of Safety Stock Optimization.

- **BUG-8**: Safety Stock Optimization fails when all products are initially excluded – If all Product records are set to Exclude, Safety Stock Optimization fails, even if a scenario is run that sets one or more products to Include. Workaround: Create a dummy product that is not demanded, but is included.

- **BUG-77**: Table dependencies for User Defined Demand Profiles do not work – If you change the name of a Period, Product or Site, existing User Defined Customer Demand Profile and User Defined Facility Demand Profile records do not reflect the new names. Related to this, records are not removed from User Defined Demand Profile tables during expansion when products or sites or both are excluded.

- **BUG-119**: Last bucket may not be generated with 5 Day Work Week – In some cases, when the Work Week option is set to 5 Day, the final bucket in the model may not be generated. This bucket is generated if the Work Week is changed to 7 Days. Also, extending the model horizon will allow the final bucket to be generated with a 5 Day Work Week.

- **BUG-165**: Incorrect Replenishment Frequency for Weekly Demand Aggregation – In some models with Weekly demand aggregation, Safety Stock Optimization is reporting the Replenishment Frequency as 0 when it should be 1.

- **BUG-179**: Safety Stock Optimization writes demand information for ignored periods – In a model that has demand only for periods 5 through 12, the demand.dat file includes entries for the first four periods.

- **BUG-188**: Safety Stock Optimization does not apply scenario items correctly when filtered on Order Time – When a scenario item includes a filter on a date, such as Order Time, the item is not applied during Safety Stock Optimization.

- **BUG-294**: Safety Stock Value is not being populated – In cases where Inventory Policies are grouped, the Safety Stock Value is not being populated even when Safety Stock is greater than 0. Workaround: Expand the model prior to running Safety Stock Optimization.

- **BUG-330**: A crash can occur if you run Demand Sampling with Safety Stock data populated for multiple scenarios – If a model has Safety Stock Optimization output populated for more than one scenario, running Demand Sampling will cause Supply Chain Guru to crash.

- **BUG-331**: Std Dev may be incorrect when you populate a distribution for Production Time and an integer for Source Lead Time – If you specify a Normal distribution for Production Time and an integer value for Source Lead Time, the calculation used with the combined values may not be correct.

- **BUG-367**: Safety Stock Optimization fails if the Period Name contains an embedded space – If your Period Name values contain embedded spaces (such as Period 1, Period 2, etc.), Safety Stock Optimization fails with “Input string was not in a correct format” error.

- **BUG-404**: Safety Stock Cost is not populated in Optimization Output Network Summary table – When running Safety Stock Optimization, the Safety Stock Cost field in the Network Summary output table is not populated.
Known Issues

- IOS-207: Lead Time Bucket Precision is not currently used during Safety Stock Optimization – Setting a specific value for the Lead Time Bucket Precision Safety Stock option is not being used when the model is solved.
- IOS-219: Demand Propagation failed – In a specific model that has no customer demand, but has demand override defined, and the customer-facing site has a BOM defined, demand propagation fails.
- IOS-223: Multi-Period model may have incorrect Lead Time Demand Distribution – In a specific multi-period model, the Lead Time Demand Dist was reported as “Mixture of distributions” rather than “Normal”.
- IOS-224: Inter-Demand Interval Mean may be reported as <1 – In a specific model, the Inter-Demand Interval Mean was reported as less than 1.

Multi-Objective Optimization

- BUG-63: Filtering on the Multi-Objective Optimization Pareto Point grid does not limit actions such as Generate Full Solution – While you can create a filter on the Pareto Point grid for Multi-Objective Optimization, this filter is not used when performing actions such as Generate Full Solution.
- BUG-286: Multi-Objective Optimization populates Scenario Name with the ID value in output tables – When Multi-Objective Optimization is run, the Optimization Output tables have the numeric Scenario ID populated for the Scenario Name.
- BUG-325: Scenario changes are not applied when running Multi-Objective Optimization full solutions – If you generate pareto points for a Multi-Objective Optimization using a non-baseline scenario, when you run a full solution on one of the points, the scenario items are not applied.
- BUG-408: For Multi-Objective Optimization, the Network Summary values do not match those in the the Multi-Objective Details table – For MOO, generate pareto points, then select one or more of the points and generate the full solutions. When complete, open the Network Summary and Multi-Objective Details Optimization Output tables. Sort the tables by Scenario. You will see that the Total Profit from the Network Summary does not always match the Objective1 value in the Multi-Objective Details.

Vehicle Route Optimization

- BUG-236: Linked fields do not update correctly in the Vehicle Route Optimization output tables – When linked fields are first added to tables (such as City and State added to the Stops table), the values are correctly displayed. After running Vehicle Route Optimization, the values in the linked fields are cleared, but not updated.
- BUG-237: Stop information is incomplete for Sites with double quotes in the name – If a Site Name includes double quotes, the Stop output table will not display the values for many of the fields.
  Workaround: Do not use double quotes in Site Name field values.
- BUG-293: VRO Summary is not populated in some cases when the computer region is set to non-US – In some cases, for some non-US regions, the VRO Summary may not be populated. This occurs when fields are improperly formatted.
- BUG-295: When a value is entered in the Transit Override Cost field, Vehicle Route Optimization fails – When Cost is populated on the Transit Override table, Vehicle Route Optimization fails with a cast error.
  Workaround: Edit the model database in Access or SQL Server Management Studio and change the data type of the Cost field on the TransitOverride table to Text.
• **BUG-297**: Asset Availability may be incorrect when date format is set to non-standard – For a specific region, if the date format for the computer is set to a non-standard format, the Asset Availability may be incorrect due to misinterpreted Start Date Time and End Date Time values.

• **BUG-431**: Default sub-scenario value is not used with VRO run with single sub-scenario – In a model that has sub-scenarios defined and the default is specified as a value other than the first in the scenario item definition, the first value is used when only the default sub-scenario is run. For example, if the values are 2, 3 and 1 (in that order), but 1 is specified as the default sub-scenario value, the solver with use the first value (2). Note that if you run all sub-scenarios, the correct values are used.

• **SCG-1958**: Error writing output tables after Vehicle Route Optimization with SQL Server models – In some cases, data could not be read into the Vehicle Route Optimization output tables for SQL Server models due to insufficient column width. Workaround: Edit the model database in SQL Server Management Studio and widen the following fields to 255 characters:
  - VROOutputAssets table:
    - AssetID
    - EquipmentID
  - VROOutputRoutes table:
    - EquipmentID

• **VRP-72**: Splitting of Shipments may result in unrouted shipments – In cases where a shipment is split based on asset capacity and the remaining shipment amount does not meet the asset fill level, the shipment is unrouted. This could be resolved by splitting in a way to meet the fill level.

• **VRP-76**: Shipment Consolidation is not occurring when the Earliest Pickup Date is prior to that of another shipment – Vehicle Route Optimization does not consolidate shipments when a shipment’s Earliest Pickup Date is prior to that of another shipment even though both shipments’ Latest Pickup Date would allow for consolidation.

• **VRP-120**: Backhaul Optimization sometimes requires excessive travel time – In some cases, Backhaul Optimization is not able to create routes unless the Max Travel Time Per Route is significantly longer than the actual route time calculated. Also, routes themselves can incur excessive times at some stops.

• **VRP-173**: Higher Asset Fixed Cost results in Unrouted shipments – In a specific model, when the asset Fixed Cost is high, the shipments that would normally be allocated to this asset are unrouted. Workaround: Exclude the asset with the high Fixed Cost.

• **VRP-214**: Asset limitations at a site are violated with Interleaved Optimization – In a specific model, a single asset is being used twice where it should only be used once.

• **VRP-230**: In Periodic VRP, Invalid Shipment "Reason" is sometimes incorrect – In a specific model, shipments have a Qty of 0 and the Key UoM is Qty. These are invalid and the Reason reported is "invalid date time format". The shipments seem to have the same date format as all other shipments, so the reason does not seem correct.

• **VRP-275**: Max Time Per Asset is violated in some cases when using Interleaved Optimization with Asset Optimization enabled – In a specific model that uses Interleaved Optimization with the Asset Optimization option selected, the Max Time Per Asset is set to 3 DAY. When the model is solved, some tours are longer than 3 days.
Known Issues

- VRP-282: Split Shipments results are inconsistent between tables when using Periodic VRP – In cases where shipments exceed the capacity of available assets, when the model is run with "Split Shipments when able" selected, the results for Total Quantity for these shipments are different between the Delivered Shipments and PVRP Delivered Shipments tables.
- VRP-292: Comp2 values in the PVRP Delivered Shipments table are doubled – When using multiple compartments in a Periodic VRP model, the Comp2 values for Qty, Weight and Cubic are doubled in the PVRP Delivered Shipments table.
- VRP-294: Asset Search Distance can be violated in Interleaved Optimization – In some cases, an asset may originate at a site that exceeds the Asset Search Distance from another site when using Interleaved Optimization.
- VRP-296: Shipment Prevent Relationship Constraints not respected in Periodic VRP – In some cases, a Relationship Constraint that prevents a shipment from being routed with specific other shipments is being violated.
- VRP-298: Routes may display a negative Route Utilization in Backhaul models – In some cases, the Route Utilization on the Routes table may be a negative value when running a Backhaul Optimization.
- VRP-299: Comp2 values may be higher than expected with Backhaul Optimization – In some cases, the Comp2 values for Qty, Weight and Cubic in the Routes table are higher than expected when running a Backhaul Optimization.
- VRP-300: Overnight break time in the Route Breaks table doesn’t match overnight break time in Stops table for Backhaul Optimization – In some cases, the Route Breaks table lists a single break that appears to be two overnight breaks in terms of duration. This occurred with a Backhaul Optimization model.
- VRP-304: Direct Shipping Cost is missing from Routes and Unrouted Shipments for Backhaul Optimization – If Shipments are populated with a Direct Shipping Cost, this value is not reflected in the Routes and Unrouted Shipments tables for Backhaul Optimization.
- VRP-307: Equipment return stop is at the same time as equipment start for Backhaul Optimization – For routes with only Delivery in-transit stops, the last stop (equipment return) on the route may have the same date/time values as the first stop (equipment start - Pickup).
- VRP-313: Baseline routes with no Sequence can cause model to be infeasible with Interleaved Optimization – In a model where Shipments are defined with a Route ID but no Sequence value, the solver returns an infeasible result.
- VRP-336: Cancelling a solve may be unresponsive – If you try to cancel a VRO solve during the improvement phase, it may not cancel immediately.
- VRP-342: Routes not showing Pickup Qty, Pickup Weight and Pickup Cubic for initial pickup – In an Asset Optimization model, where the first stop is Equipment start - pickup, the Routes table is not displaying the Pickup Qty, Pickup Weight and Pickup Cubic.
- VRP-358: Output for Periodic Optimization may indicate incorrect Product – In some cases, the Product that is populated in Delivered Shipments and PVRP Delivered Shipments may not be correct.
- VRP-372: Pickup Sequence not respected in Baseline model when using Interleaved Optimization – In some cases, the Pickup Sequence ID assigned to shipments when using Baseline modeling is not respected when running Interleaved Optimization. The shipments are placed on the correct routes.
Auto Implement Optimized Model

- **BUG-443**: Auto Implement Optimized Network is removing required policies – In some cases, the Auto Implement Optimized Network function is removing policies that are required for Network Optimization. As a result, the (Optimal) model generated by Auto Implement may be infeasible.

GeoCoding Guru

- **BUG-116**: Batch GeoCode is not updating the Postal Code and Country values in all cases – With Save Missing Values or Replace All Values and Guru Data selected as the provider, Batch GeoCode is not updating the Postal Code and Country values, even in records where these are not populated. When performing the same operation on a single record with Address Search, the values are updated.
- **BUG-162**: Misspelling of city name in GeoData.sgd – The GeoData table in the database includes an entry called Nississauga ON. This should be Mississauga.

Routing

- **BUG-112**: Google Web Service does not return Transport Time – When using the Google Web Service as the Road Distance provider, the Distance is populated, but Transport Time is returned as 0 HR.
  - Workaround: Use the Bing Web Service as the Road Distance provider.
- **BUG-195**: Co-located sites get incorrect Transport Time from a previous record when using Road Distance – When using Road Distance with Bing as the provider, Origin and Destination sites that are co-located (that is, have a Distance = 0) are incorrectly getting the Transport Time value from the previous record.
- **BUG-227**: Road Distance calculation with ESRI local data may populate invalid Transport Time – In some cases, when using a local ESRI data source as the provider for the Road Distance tool, the Transport Time is returned with an invalid value, such as 876660.51 HR. If you use Bing as the provider, the Transport Time values will be valid.

Tables and Grids

- **BUG-47**: Characters not cleared on status window running model with a long name followed by one with a shorter name – If you run a model with a long name, then run another with a shorter name, characters from the longer model name are still displayed on the Optimization Status and Simulation Status windows in the Model field.
- **BUG-141**: Field Guru form is behind the application window when focus is changed – If you open a field guru, then switch to an application other than Supply Chain Guru, when you return to SCG, the field guru form is hidden behind the SCG window.
- **BUG-189**: Product Classification Tool does not display percentage for Classifications – All classifications are showing 0% in the Classes pane.
- **BUG-332**: Filter for numeric value is not always correct with a text field – For example, the Sourcing Policies table has Avg Unit Cost values of 1, 1.10 and 1.12. If a filter of > 1.1 is applied, it returns values of 1.10 as being greater than 1.1 because the field is actually a text field.
- **BUG-334**: In the Forecasts table, if you select the field guru before entering a number, you get an error regarding Quantities – In the Forecasts table, if you enter a Name, then click the field guru, you get an error that the "Field ForecastQuantities cannot be left blank. Please enter a value for this field."
Known Issues

Workaround: Enter a number in the Quantities field. You can then successfully access the field guru.

- **BUG-418:** Edited filter definition to remove characters is not saved – With an invalid filter definition such as: ="2 when you edit the filter to remove the double quote character (=2), it is not reflected as an edit, so you cannot save the definition without the quote. Also, if you remove the double quote character and save the filter with a new name, it also reverts to the ="2 format.
  
  Workaround: Edit the filter to something different, such as =3, save it, then edit again to =2 and save again.

- **BUG-439:** Error message updating column values with filter on Notes field – With a specific model, if a filter was applied to the Notes field in the Sourcing Policies table, trying to update field values using the Column Update feature resulted in an error message being displayed. The field values were not correctly updated.

Charts and Graphs

- **BUG-105:** The Customer Flows Service Distance Histogram and Customer Flows Service Hours Histogram graphs (on the Optimization tab) do not clearly distinguish different scenarios.

- **BUG-127:** The Time Series Graph for Simulation may display incorrect In-Transit Units – In some cases, the In-Transit Units are actually displaying the value for the Backorder Units.

- The Vehicle Route Optimization charts that include both Shipments and Routes as Graph Fields currently display the number of shipments, rather than the actual number of routes, when Routes is selected.

Scenarios

- **BUG-107:** Using a scenario to update Book Value - The Book Value cannot be changed in a scenario in a conventional way. Outputs show that the Baseline values are propagated throughout each scenario.

- **BUG-208:** Using a scenario to set the CO2 value in Transportation Assets – When running Vehicle Route Optimization on a scenario that sets the CO2 value on the records in Transportation Assets, there is no CO2 calculated in the output. If you manually enter CO2 values into the Transportation Asset records and run with VRO, CO2 Emission is calculated for the Routes and Segments.

- **BUG-217:** Scenario Filter edited in table does not reflect updated criteria in scenario – Create a scenario and define a filter. The filter has a name such as “(Scenario) Filter1”. Open the table that the filter applies to, change the filter criteria and Save the currently applied filter. The filter is saved, but is renamed "Filter1" (the "(Scenario)" flag is removed). In the Scenario definition, the filter is now an editable filter, but the criteria is still as defined initially.

- **BUG-292:** Scenario does not change model horizon dates – Scenario items that are used to change the model horizon start and end dates do not use the updated dates when the model is run in memory.
  
  Workaround: Expand the model first to have the updated dates applied, then run the model.

- **GCX-5:** Distance Reqt value for Service Requirements is not changed when using scenarios with in memory processing – If you create a scenario to change the Distance Reqt value in the Service Requirements table, this value is not being used during Network Optimization.
Workaround: You can manually expand the model, selecting this scenario, to have the new value applied.

Import/Export

- BUG-184: Relationship Constraint table does not export and import groups the way other tables do – In SCG tables, when you use Excel Export, fields that contain group names do not include the "(Group)" prefix when written out. When reading these records back in, SCG resolves these for you and associates the value with the group. With the Relationship Constraint table, the group names are written out as "(Group) AllDCs". If you are creating data outside Guru and do not include the "(Group)" prefix in the value, they are not imported correctly (no match to the actual group).
  Workaround: Include the "(Group)" prefix with group names when importing into the Relationship Constraint table.

- SCG-627: Export to Excel csv format causes “Index out of range” error – If you use the Export to Excel function on a table with more than 1,048,576 rows, the export fails with a "Row or column index is invalid or out of range." error.

- SCG-1862: Network Summary field name difference on Export – When exporting the Network Summary optimization output table, the Total Min Inventory field is labelled as TotalSafetyStock in the Excel table.

Maps

- BUG-36: Class Break values may be inconsistent between Sites and Shaded Areas – In some cases, the value that defines a class break may vary between breaks on Sites and Shaded Areas, even if both are using the same table and field to determine the break.

- BUG-39: Show Sites from Greenfield Facilities includes Class Breaks and Colors section – For a Sites layer on the map, when “Show Sites from” is set to Greenfield Facilities, the Class Breaks and Colors section is included in the Layer Properties areas. This section should not be included.

- BUG-49: Flows lines with scaled density are not displayed correctly with arrowheads in the middle of the flow line – On a map, if you scale the density of Optimization Flows by Flow Units, then use an arrowhead that is in the middle of the flow line, the density shading is only displayed up to the arrowhead. The remainder of the line is displayed in the solid (most saturated) color selected for the flows.

- BUG-55: Risk Map Layer Navigator is incorrect for the Political Instability Index – When this index is selected, the colors on the map are correct for the layer type, but when you move the cursor off that layer and back on, the list box does not reflect that this is the layer type that is selected. This issue only affects the Political Instability Index.

- BUG-64: Custom Presentation Max Line Weight not maintained – For a map layer such as OptimizationFlow, if you enable Use Custom Presentation and set the Size to (Scaled), then Scale Size By a field value (such as Flow Weight), you can define a Min and Max line weight. When the project is reopened, the Max line weight is always reset to the thickest line weight.

- BUG-65: Panned view for Quick Zoom does not maintain panned location – On a map, when zooming in and then panning to a new center point for the view, a named Quick Zoom view retains the zoom factor, but is not keeping the panned center point.

- BUG-120: Shaded Area Layer color changes not working as expected – On the Shaded Area Layer, click on the Start color, change the color and click OK. The color for the first break is changed, then the color palette is displayed again. You have to
Known Issues

click OK a second time to have the set of break colors adjusted. Select the End color. Pick a new color and click OK. Only the last break color is updated. The set of break colors is only adjusted when the Start color is changed.

- BUG-122: Only one Service Area Layer can be saved in a project - This is a current limitation with the Service Area map layer. You cannot save a project if your model has more than one Service Area map layer defined. Note that you can create multiple solutions on a single Service Area map layer. If you save a project with multiple Service Area Layers, you will get an error. The project file may be corrupted and no longer valid to open. In that case, you will need to create a new project, add the model to the new project and redefine the map.

- BUG-132: Customer from Source on Map not correct for specific project - In a specific project, the colors of the customer sites do not seem to be correct based on the source.

- BUG-171: Greenfield Facilities Filters are not available for Service Area Maps - If you have defined filters on the Greenfield Facilities table, these filters are not currently available when defining Service Area Map solutions.

- BUG-260: Sites on the coast of the Netherlands are not rendered well with Service Areas - When generating Service Area Layers along the coast of the Netherlands, the existing ESRI road network has many gaps that result in holes and uneven looking results.

- SCG-2349: Changing Start/End Color with no Shaded Areas displayed causes crash - If there are currently no breaks displayed in the Class Breaks area of the Layer Navigator and you attempt to change the Start or End Color, the application crashes.

Visual Modeler

- BUG-92: Filter settings are not maintained when project is closed and reopened - On the Visual Modeler, you can use Custom Table Filters to limit the display on a layer. However, when the project is closed and reopened, the filter settings are not maintained.

Tabular Reports

- BUG-108: Scenario field in Tabular Reports - When exporting a Tabular Report to Excel, the Scenario field on the Tabular Report exports as Scenario ID (the numeric value rather than the name).

Product Classification Tool


Cloud

- BUG-299: Simulation results are different for a Cloud solve when the model uses a rate table for an input pipe - When solving on the Cloud, if a rate table is used as the data source for an input pipe, the values are not being populated correctly. As a result, the solution on the Cloud may vary from that when run locally.

- BUG-300: Model Experiment Time in Network Summary output table is empty for simulations performed on K2 Cloud - When you run a model on K2 Cloud, the Model Experiment Time in the Network Summary Simulation Output table is not populated.
- **BUG-312**: Embedded carriage return causes import failure on Cloud – In this case, the Fixed Operating <Cap,Cost> value had an embedded carriage return that split the value into two lines. The model is successful when run locally, but fails on K2 Cloud during import.

- **BUG-391**: Sub-Scenario ID wizard does not work for models solved on the Cloud – If you run a model with sub-scenarios on K2 Cloud, after import, the wizard on the Sub-Scenario ID field in the various output tables does not display the sub-scenario value used. When clicking on the Sub-Scenario ID, you see a message “There are not any output value details found for this Scenario.”

**Localization**

- **BUG-83**: The date format on the Optimization Output Network Summary table is always US format – When the region on the computer is set to a region that uses a non-US format date, the Model Run Time in the Network Summary table displays the date in US format.

- **BUG-192**: Road Distance and Field Guru are inconsistent in writing Distance/Transport Time with regional settings – When the computer region is set to a non-US format, the Road Distance tool populates the Distance and Transport Time in Transportation Policies with US format settings (period as the decimal character). When using the field guru on the Distance field to calculate distance, the local format is applied (such as 53,21).

- **BUG-204**: Non-US region causes the clock to behave incorrectly in Simulation – With the computer region set so the date is dd/mm/yyyy, run Simulation, ensuring that the Simulation Clock On is checked. When the model reaches 1/12/2104, the clock stops, even though the Simulation keeps running.

- **BUG-313**: Verify Model reports error with non-US settings due to Product Class being 77,5 – If you create a new Product when the computer region is set to non-US, the default Product Class value is set to 77,5. When you run Verify Model, this Class value is reported as an invalid value.

- **BUG-337**: Text fields that accept numbers do not display with regional format when region is changed – With region set to English (United States), enter 1.5 in the Transportation Policies Average Cost field. Change the region to German (Germany) and open the same model. The value is still displayed as 1.5. Note that this value will work correctly when the model is solved.

- **BUG-339**: GHG Text fields that accept numbers cause solver to fail when comma with no integer is used – With region set to non-US, such as German (Germany), enter ,55 as the Carbon Cost value in the Greenhouse Gases table. Network Optimization fails trying to generate the Params.dat file.

- **BUG-340**: Field Gurus for numeric entry do not support the comma as a decimal character – On the Demand table, click the field guru for Quantity. Enter 125,5 in the Number field. The value is actually displayed as 1255.

- **BUG-341**: Step Costs field guru not working correctly when localized format is used for values – With region set to non-US, such as German (Germany), on the field guru for Fixed Operating <Cap,Cost> in the Sites table, enter 0 for the Capacity value and 150,5 for the Cost, then Paste. The value is displayed as <0,150,5>. Network Optimization interprets the value 1505. Click on the field guru again. The value is no longer displayed.

- **BUG-342**: Time Unit fields with comma for decimal and no integer value can cause failure – With region set to non-US, such as German (Germany), enter ,75 HR in the
Work Time Per Unit of the Processes table. Network Optimization fails trying to write the Processes.dat file.

- **BUG-343**: If a scenario sets a value with a comma for the decimal and no integer, the update is ignored – With region set to non-US, such as German (Germany), if you create a scenario item that multiplies the Demand Quantity by .75 the scenario change is ignored.

- **BUG-344**: If a scenario sets a date value with the local format, the update is ignored – With region set to non-US, such as German (Germany), if you create a scenario item that sets the Start Date in the Asset Availability table to 15.09.2014 (German format), the scenario change is ignored.

- **BUG-345**: Max Sourcing Distance Greenfield Option does not support decimal with non-US format – In Greenfield Options, enter a Max Sourcing Distance of 525.5. The comma is not allowed. Enter a value of 525.5 and click Apply. When you reopen the options, the value is 5255.

- **BUG-346**: Optimization Tolerances are not handled correctly with non-US region if a comma is used – For example, with a non-US region, if .001 is entered for the Feasibility Tolerance, when you run Network Optimization, it uses the default value rather than the value entered.

- **BUG-347**: Time unit fields with a comma as the decimal are interpreted incorrectly for Vehicle Route Optimization – With a non-US region, entering a value of 1,25 HR for Fixed Service Time is interpreted as 60 minutes, not 75.

- **BUG-348**: Fields with a comma as the decimal are written incorrectly for Vehicle Route Optimization input files – With a non-US region, entering a value of 82,5 for Speed in the Transportation Assets field causes the input file to be written incorrectly.

- **BUG-350**: Filters may return incorrect values when using a comma as the decimal character – For non-US regions, if you have values such as 0,19 and 0,22 in a numeric field, a filter of > 0,2 does not return the 0,22 value. Workaround: Change the criteria to > 0.2 and the correct results are returned.

- **BUG-351**: If a comma is used in a value for a step cost in the Rate table, no cost is incurred – With a non-US region, on the Rates table enter Per Distance Cost=1,8. Run Vehicle Route Optimization. These are written to the Rates.csv file as "1,8" but no cost is incurred.

- **BUG-352**: Shipments Builder fails with non-US region – If the current region is set to a non-US region such as German (Germany), the Shipments Builder does not generate any shipments.

- **BUG-357**: Vehicle Route Optimization Options with commas are not handled correctly – For example, with the computer set to a non-US region, if you enter the Route Selection Optimality Gap on the Interleaved Optimization tab, enter 0,05. It is changed to 5.

- **BUG-358**: Demand Classification Threshold values do not accept a comma – If the current region is set to a non-US region such as German (Germany), when you try to enter a value with a comma for a Demand Classification Threshold field, the comma is not accepted.

- **BUG-359**: Demand Sampling fails with non-US region – If the current region is set to a non-US region such as German (Germany), Demand Sampling fails.

- **BUG-361**: For numeric values written out as, if the value uses a comma as the decimal character, only the integer is used – For fields such as Price, if the value uses a comma, such as 100,99 only the integer component is used.
Known Issues

- **BUG-362**: For numeric values written out in quotes, if the value uses a comma as the decimal character, only the integer is used – Some numeric values are written out to the input file in quotes, such as Occurrences. If you enter a value such as 2,5 only the integer component is used.

- **SCG-1032**: Field level context help does not work when a language other than English is selected.

- **SCG-2081**: Copying and pasting records with Chinese characters does not work – When you copy and paste records with Chinese characters, you may get ”????” in place of the characters. If you are copying individual field values the characters are correctly copied.
  Workaround: If you highlight the text in a specific cell first, then copy and paste, the characters are copied correctly.

Help

- **BUG-252**: Ctrl-F1 key combination toggles the UI ribbon, but also launches Help – This Ctrl-F1 key correctly hides/unhides the ribbon at the top of the UI. However, it also opens the online help in a browser window.
Chapter 3

Installation

Topics in this section include:

- System Requirements
- Prerequisite Software
- Optional Software
- Installing Supply Chain Guru
- Supply Chain Guru Licensing
- Web Services Information

System Requirements

Supply Chain Guru works on Windows-based systems. For additional information about system requirements and recommendations, refer to “System Requirement Details” on page 39.

**Note:** As of version 8.1, Windows XP is no longer a supported operating system for Supply Chain Guru.

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum System Requirements (Simple Models)</th>
<th>Recommended System Requirements (Detailed Models)</th>
<th>Recommended System Requirements (Large Models)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>2.0 GHz Pentium-compatible PC</td>
<td>PC with 3 GHz processor</td>
<td>PC with 3 GHz (or greater) processor</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel i5 Processor</td>
<td>Intel i7 Processor</td>
<td>Intel Xeon Processor, minimum 3GHz</td>
</tr>
</tbody>
</table>
## System Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum System Requirements (Simple Models)</th>
<th>Recommended System Requirements (Detailed Models)</th>
<th>Recommended System Requirements (Large Models)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Service Pack requirements: Windows 7 SP1&lt;br&gt;Windows 8: no Service Pack requirements&lt;br&gt;Windows 8.1: no Service Pack requirements&lt;br&gt;Windows Server 2008 R2 SP1 or Windows Server 2008 SP2&lt;br&gt;Windows Server 2012 or Windows Server 2012 R2</td>
<td>Windows 7 64-bit&lt;br&gt;Windows 8 64-bit&lt;br&gt;Windows 8.1 64-bit</td>
<td>Windows 7 64-bit&lt;br&gt;Windows 8 64-bit&lt;br&gt;Windows 8.1 64-bit</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>Microsoft .NET Framework 3.5 SP1 and Microsoft .NET Framework 4.5.1 needs to be installed as described in &quot;Prerequisite Software” on page 40.</td>
<td>Microsoft .NET Framework 3.5 SP1 and Microsoft .NET Framework 4.5.1 needs to be installed as described in &quot;Prerequisite Software” on page 40.</td>
<td>Microsoft .NET Framework 3.5 SP1 and Microsoft .NET Framework 4.5.1 needs to be installed as described in &quot;Prerequisite Software” on page 40.</td>
</tr>
<tr>
<td>RAM</td>
<td>3 GB RAM minimum</td>
<td>8 GB RAM</td>
<td>16 or 32 GB RAM</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>250 GB HDD @7200RPM 100 GB disk space free (1 GB for installation)</td>
<td>500 GB HDD @7200 RPM or 240 GB SSD 100 GB disk space free (1 GB for installation)</td>
<td>2x 500 GB HDD @ 7200 RPM or 480 GB PCI-e SSD 100 GB disk space free (1 GB for installation)</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1024 x 768</td>
<td>1600 x 900 or higher</td>
<td>1600 x 900 or higher</td>
</tr>
<tr>
<td>Internet Connectivity</td>
<td>Internet connectivity is required in order to make use of the geocoding and routing providers Esri and Bing, and for retrieving RateWare XL online data.</td>
<td>Internet connectivity is required in order to make use of the geocoding and routing providers Esri and Bing, and for retrieving RateWare XL online data.</td>
<td>Internet connectivity is required in order to make use of the geocoding and routing providers Esri and Bing, and for retrieving RateWare XL online data.</td>
</tr>
<tr>
<td>License Server Connectivity</td>
<td>If you have roaming or floating Supply Chain Guru licenses, you must have connectivity to the license server machine.</td>
<td>If you have roaming or floating Supply Chain Guru licenses, you must have connectivity to the license server machine.</td>
<td>If you have roaming or floating Supply Chain Guru licenses, you must have connectivity to the license server machine.</td>
</tr>
</tbody>
</table>
Model Size
The following table provides general guidelines about what are considered simple, detailed and large-scale models:

<table>
<thead>
<tr>
<th>Component</th>
<th>Simple Models</th>
<th>Detailed Models</th>
<th>Large-Scale Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Elements</td>
<td>&lt;20 Sites, &lt;50 Products, &lt;10k Demand points, Single Time Period, Some alternatives in sourcing or transportation</td>
<td>40-500 Sites, 50-300 Products, 10k-50k demand points, multiple alternatives to sourcing or transportation</td>
<td>500+ sites, 300+ products, 50k+ Demand points, many variations on transportation, sourcing, or many time periods</td>
</tr>
<tr>
<td>Model Size</td>
<td>&lt;30MB</td>
<td>30MB-100MB</td>
<td>&gt;100MB</td>
</tr>
<tr>
<td>Technologies</td>
<td>Basic Optimization, Very Basic Simulation</td>
<td>Intermediate Optimization, Basic Simulation</td>
<td>Advanced Optimization, Intermediate or Advanced Simulation</td>
</tr>
</tbody>
</table>

System Requirement Details
Supply Chain Guru can take advantage of specific aspects of your system’s hardware, especially during optimization and simulation.

CPU Performance
CPU speed can significantly affect solve time for all model sizes. Supply Chain Guru can make use of Parallel MIP where multiple cores work to solve a single problem. Multiple-core processors are recommended to take advantage of this feature.
Minimum CPU: Intel Pentium 3 or equivalent
Recommended CPU: Intel Core i5 or i7 CPU or equivalent, Intel Nehalem-based Xeon servers.

Memory Considerations
Memory typically has little or no impact for small models. For larger models, memory is a consideration. If the optimization requires more memory than the available physical memory, the operating system will page in virtual memory. This will significantly degrade performance.
If you have a multi-core processor, Supply Chain Guru will use the available threads on the machine and solve the problem as a Parallel MIP. In this case, the amount of memory required is proportionally increased to the number of threads being used.
Memory recommendations:
- 4GB for 32-bit systems (32-bit systems are limited to no more than 3GB for user mode applications, such as Supply Chain Guru and the remaining 1GB will be used to run the Windows Operating System and other programs).
- 8GB or more for 64-bit systems.
Disk Speed
Performance is typically not affected unless you are running models from network drives or slower media such as USB flash drives. Supply Chain Guru models generally benefit from the speed increases provided by Solid State Drives (SSDs) over standard hard drives.

Operating Systems
Due to the availability of larger amounts of memory, LLamasoft recommends that you use Supply Chain Guru on a 64-bit system. 32-bit systems are limited to 2GB or 3GB of physical memory for user mode applications. 64-bit systems do not have this limit and are suitable for solving large models.

Displays on Laptops and Tablets
Some Microsoft Surface users have experienced display issues while working in Supply Chain Guru. Symptoms include partial display of icons and tabs, and missing text on pop-up windows. Typically, these issues are easily corrected by changing your display scaling. Refer to the following Microsoft article to change your Microsoft Surface display settings:
Users of other tablets or laptops experiencing display issues can adjust their settings in Control Panel > Display. Usually, selecting the Smaller setting will resolve this problem.

User Agent and Host Access
User Agents are called and remote hosts are accessed for a variety of functions relating to Supply Chain Guru:
- Supply Chain Guru installation
- Supply Chain Guru web update
- RateWare XL Server data lookups
- ArcGIS web-based maps
- Bing geocoding and distance calculations
In order for these functions to operate correctly, you must enable access to the specified user agents and remote hosts. For information about enabling access to user agents and remote hosts, refer to “Web Services Information” on page 57.

Prerequisite Software

**Microsoft .NET Framework**
Microsoft .NET Framework 3.5 SP1 is required for Supply Chain Guru maps to function properly. The installer will detect if this component is not available and prompt you to install it.

**Note:** This version of the .NET Framework is part of the Windows 7 operating system, so you will not need to install it in this case.
You can also download and install Microsoft .NET Framework 3.5 from Microsoft’s website:

Microsoft .NET Framework 4.5.1 is required for Supply Chain Guru to function properly. For Microsoft .NET Framework 4.5.1, be sure you install the full framework, not the client profile.

**Note:** Windows 8 and Windows 8.1 comes with Microsoft .NET Framework 4.5 installed.

To ensure that the Microsoft .NET Framework 4.5.1 is currently installed on your computer:
- Use the Windows Start button to open Control Panel.
- Select Programs > Programs and Features (on Windows 7 or Vista).
- If the application is already installed, it will be listed in the program list as Microsoft .NET Framework 4.5.1.

If currently not installed, the Supply Chain Guru install center will prompt you to install .NET Framework 4.5.1 when you try to run Supply Chain Guru. You can also download and install Microsoft .NET Framework 4.5.1 from Microsoft’s website:
http://dotnetsocial.cloudapp.net/GetDotnet?tfm=.NETFramework,Version=v4.5.1

**ArcGIS Engine Runtime**

Supply Chain Guru requires the ArcGIS Engine Runtime Engine version 10.0.4400 from ESRI. This application is installed as part of the Supply Chain Guru installation process when you use the Supply Chain Guru install center.

**Optional Software**

**Microsoft Office**

Supply Chain Guru supports use of files in Microsoft Access and Microsoft Excel formats for a variety of functions. For example, Supply Chain Guru tables can be imported from or exported to Microsoft Excel and Supply Chain Guru input pipe data sources can be Access or Excel files.

If you wish to use these features of Supply Chain Guru, LLamasoft recommends that you have Microsoft Office installed on the same machine as Supply Chain Guru.

**Microsoft SQL Server**

You can create Supply Chain Guru models in Microsoft SQL Server format, as well as in Access format. Supply Chain Guru requires that you use a local instance of the SQL Server database. Remote databases are not supported.

If not already installed, SQL Server 2014 Express will be installed as part of the Supply Chain Guru installation process. The SQL Server 2014 database instance will be used as the default for Supply Chain Guru. If you have an older version of SQL Server installed on your system:
- The existing version will be maintained and SQL Server 2014 Express will be installed as a stand-alone installation using the Supply Chain Guru Install Center.
All SQL Server models created, opened, copied, expanded or converted using Supply Chain Guru will be in the SQL Server database version of the Local Server Instance selected in Supply Chain Guru.

You can continue to use your older version of SQL Server with Supply Chain Guru if required. By default, the Local Server Instance on the SQL Server tab of Application Preferences will remain set to the existing SQL Server instance. For example, if you have been using the SCGSQLEXPR2008R2 instance, your models are currently in SQL Server 2008 R2 format. To continue to use this version of SQL Server, the SCGSQLEXPR2008R2 instance should be selected as the Local Server Instance:

Once models have been upgraded to a new version of SQL Server, you cannot open them with an older instance. For example, if you open a model with a SQL Server 2014 instance selected, you will not be able to open that model when the instance is set to a SQL Server 2008 instance.

Basic Supply Chain Database

The Basic Supply Chain Database files that are installed with Supply Chain Guru are in SQL Server 2008 R2 format. These are installed to the Supply Chain Guru installation folder, typically C:\Program Files (x86)\Supply Chain Guru for 64-bit operating systems.
Whenever you start Supply Chain Guru, the Basic Supply Chain Database files are copied to a special user folder: C:\Users\<username>\AppData\Local\LLamasoft\SupplyChainGuru. These files will be in the format for the SQL Server instance you select in Supply Chain Guru. This allows you to switch instances in Supply Chain Guru and still be able to work with your models, regardless of the database format.

**Server Instances**

During installation of SQL Server using the install center, a local server instance called LLAMASOFT2014 is created. If you have been using another version of SQL Server with Supply Chain Guru, the Local Server Instance on the SQL Server tab of Application Settings in Supply Chain Guru will remain set to your existing instance.

You can use the Local Server Instance setting to select the instance for the version of SQL Server you wish to use with Supply Chain Guru. Whichever instance is selected when you create, open, copy, convert, or expand SQL Server models determines the database version for the model. Models created in an older database version will be automatically upgraded if the currently selected instance is newer. However, once a model has been upgraded to a new version of SQL Server, you will not be able to open it with an older instance.

You can determine the version of SQL Server for each Local Server Instance using the **Info...** button on the SQL Server tab of Application Settings. For example, when the SQL Server 2014 instance is selected, the **Info...** button returns the following information:

![SQL Server Information](image)

The following table lists the version numbers for several common SQL Server Express versions and service packs:

<table>
<thead>
<tr>
<th>SQL Server Version/Service Pack</th>
<th>Version Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server 2008 R2 SP1</td>
<td>10.50.2500.0</td>
</tr>
<tr>
<td>SQL Server 2008 R2 SP2</td>
<td>10.50.4000.0</td>
</tr>
<tr>
<td>SQL Server 2012 RTM</td>
<td>11.00.2100.60</td>
</tr>
<tr>
<td>SQL Server 2014</td>
<td>12.0.2000.80</td>
</tr>
</tbody>
</table>

Visit this Microsoft Support page for additional details:
http://support.microsoft.com/kb/321185

**SQL Server 2014 and Operating System Compatibility**

For details about compatible service packs per Windows operating system when using SQL Server 2014, visit this Microsoft Support page:
SQL Server Services

Each instance of SQL Server is associated with a Service that can be started and stopped using Control Panel > Administrative Tools > Instances. You can determine whether each service starts automatically whenever the computer is started or if it must be started manually. In the following image, there are 3 SQL Server instances. LLAMASOFT2014 is set to start automatically, the other two instances require a manual start:

You can also start a SQL Server instance service from within Supply Chain Guru. On the SQL Server tab in Application Preferences, select the Local Server Instance you wish to
start. If not already started, the Start SQL Service button will be enabled. Click this button to start the currently selected instance:

**Additional Notes regarding SQL Server**

Please note the following with regard to SQL Server installation:

- If you are working on a Windows 7 or Windows 8 system and Microsoft SQL Server 2014 is not currently installed, SQL Server 2014 Express will be installed as part of the Supply Chain Guru installation process. The Supply Chain Guru installer detects what version of Microsoft Office is installed (32-bit or 64-bit) and install the corresponding version of SQL Server Express. If Microsoft Office is not installed, the 32-bit version of SQL Server Express is installed.

- When using SQL Server on a Windows 8 system, you must enable .NET 3.5. .NET 3.5 is provided with Windows 8, but is not enabled by default. If you do not enable it, you will receive compatibility warning errors when you start.

You can find Installation information for SQL Server 2014 in the [SQL Server 2014 Express Install and Configuration Guide](http://support.llamasoft.com) located on support.llamasoft.com in the Downloads section.

If you want standard (non-administrator) users to use SQL Server with Supply Chain Guru, and you have upgraded from a previous version of Supply Chain Guru, you may need to enable the “Allow service to interact with desktop” setting for SQL Server for the
specific instance. In Services available through the Control Panel, right-click on the SQL Server service and select Properties. On the Log On tab, enable “Allow service to interact with desktop”.

**Google Earth**

You can use Google Earth to view Supply Chain Guru maps. If Google Earth is installed, you can open Supply Chain Guru maps in Google Earth. If Google Earth is not installed, you have the option to export your Supply Chain Guru maps to .kmz format files which can then be opened in Google Earth.

To download Google Earth, use the following url:

http://www.google.com/earth/download/ge/agree.html

For information about using Google Earth with Supply Chain Guru maps, see the Supply Chain Guru online help.

**Bing Geocoding Service**

Bing is a transactional geocoding service provided by Microsoft and requires an account in order to use it. Bing results in successful geocoding in many cases of different spellings and structures (for example, state specified vs. not specified). In many cases, it can accurately interpret either a local language, English, or alternate spelling of names for streets and cities. In some areas, such as Eastern Europe, providing postal code information may result in Bing not successfully geocoding sites.

As a licensed Supply Chain Guru® user, LLamasoft provides a complimentary Bing Maps license key as part of your Annual Maintenance and Support. The instructions below outline how to activate your license. If you have not received your license, please contact licensing@llamasoft.com.

**To activate Bing Maps:**

1. Run Supply Chain Guru.
2. Select File > Application Settings.
3. Click on the Authentication Keys tab.
4. Copy and paste the Bing Account Key provided by LLamasoft.
5. Click Apply.

You must also update the ArcGIS installation to recognize the Bing key.

**To set the Bing Key for ArcGIS:**

1. On machines with a 64-bit operating system, select Set Bing Key from the Supply Chain Guru start menu. You see the Set Bing Key form.
   On machines with a 32-bit operating system, using File Explorer, navigate to the C:\Program Files\ArcGIS\Engine10.0\bin folder, then double-click on SetBingKey.exe. You see the Set Bing Key form.
   2. Copy and paste the Bing Account Key provided by LLamasoft
   3. Click OK.

**Note:** The SetBingKey.exe program can also be accessed from the ArcGIS program folder location. This is C:\Program Files (x86)\ArcGIS\Engine10.0\bin on 64-bit systems or C:\Program Files\ArcGIS\Engine10.0\bin on 32-bit systems.
Bing can then be used like any of the other geocoding sources.

If you are not a licensed user that has an Annual Maintenance and Support agreement with LLamasoft, you may create a temporary license key using the process outlined below.

**To create a temporary Bing Maps license key:**

Go to: http://www.bingmapsportal.com and complete the process to create a free account. Once you create an account, you will have an option to create a "key." When prompted, enter the following values:

- Application: Supply Chain Guru
- URL: http://localhost
- Key type: Trial
- Application Type: Private Website

At the end of this process, you will be given a long, alphanumeric key that you can copy and paste into Supply Chain Guru in Application Preferences on the Authentication Keys tab. Bing can then be used just like any of the other geocoding sources.

**Tableau**

Supply Chain Guru supports use of Tableau software for analyzing your Supply Chain Guru model data. Tableau supports a large number of data visualizations. Default Tableau view templates are provided with the Supply Chain Guru installation.


**RateWare XL Server**

Supply Chain Guru supports RateWare XL from SMC³ for obtaining tariff rates. These rates are based on origin, destination and weight of shipments and the freight class of products. You must set up an account with SMC³ and indicate that you are calling RateWare XL from within Supply Chain Guru from LLamasoft.

(Note: You must have a valid internet connection to connect to RateWare XL.)

Once you set up an account for RateWare XL, you enter the settings for your account in Supply Chain Guru’s Application Settings, on the RateWare XL tab. You will enter:

- License Key
- User Name
- Password
- Tariff Table
- Tariff Effective Date

(Note: You can click Validate to confirm the connection to RateWare XL. If you enable the Show Password setting, the password characters will not be masked with asterisks (*).)

Once you have set up your RateWare XL connection, rates from the selected Tariff Table will be automatically retrieved when you are setting transportation costs. On the
Transportation Policies table, the Field Guru for the Cost and Average Unit Cost fields includes a Rate Services section with a RateWare XL option. If this option is enabled, rates are retrieved from the online RateWare XL server tables.

When working with RateWare XL:
- needs the following information to return a rate:
  - Origin Postal Code (Postal Code from Sites table)
  - Destination Postal Code (Postal Code from Sites table)
  - Product Freight Class (Class value from Products table)
  - Shipment Size (Shipment Size from Transportation Policies table)
- The Transportation Policy can be based on groups.
- The Cost Basis will automatically be set to LTL Rating when using a rate lookup through RateWare XL. This basis behaves the same way as Fixed rating.
- For optimization, the Shipment Size field is used to calculate the number of trips, so you must provide this value when using RateWare XL rates in the Average Unit Cost field.

**Installing Supply Chain Guru**

If you are installing Supply Chain Guru for the first time, or updating from an earlier version of Supply Chain Guru, you must use the install center. For upgrades from earlier versions of Supply Chain Guru, LLamasoft recommends that you uninstall the previous version of Supply Chain Guru and restart your machine. Uninstalling the previous version ensures that older shortcuts and other items related to the previous version are correctly removed.

**To uninstall Supply Chain Guru**
1. Select **Start > Control Panel > Programs & Features** or **Uninstall a program**.
2. Select **Supply Chain Guru**.
3. Click **Uninstall**.
4. Follow the uninstall process for Supply Chain Guru.

In cases where SQL Server Express is installed as part of the Supply Chain Guru installation process, the restart also ensures that any Windows updates or other configuration changes are completed prior to the SQL Server Express installation. If these changes are not complete, SQL Server Express may fail to run successfully.

**Installation Requirements**

The following are requirements to successfully install Supply Chain Guru:
- You must have Administrator privileges to run the Supply Chain Guru installer.
- Supply Chain Guru is not supported in an environment with encrypted folders. The target folders for Supply Chain Guru installation cannot be encrypted or installation will fail.
- If your operating system is Windows 7 or newer, LLamasoft recommends that you set the **User Account Control Settings** to "Never notify".
**Installation Supply Chain Guru and required Third Party Software:**

**To download and use the installation program:**

1. If you have ArcGIS Engine Runtime version 9 or earlier installed, uninstall this program through **Control Panel > Programs and Features > Uninstall/Change**.
2. If your computer system does not have the required Service Pack installed, use Windows Update to install the required Service Pack.
3. You will need to download the Supply Chain Guru Install Center. Two installers are available, depending on which version of SQL Server 2014 Express you want to install. The installers are found on [support.llamasoft.com](http://support.llamasoft.com) under **Downloads**.
   - **SCG Install Center 8.2k w SQL2014 32bit.exe** – Use this install center to install Supply Chain Guru and SQL Server 2014 Express 32-bit.
   - **SCG Install Center 8.2k w SQL2014 64 bit.exe** – Use this install center to install Supply Chain Guru and SQL Server 2014 Express 64-bit.

**Note:** The 32-bit version of SQL Server 2014 will work on computers with 64-bit operating systems.

Use the Install Center in the following cases:

- You do not have Supply Chain Guru installed on the machine.
- You have a Windows 7 or Windows 8 system and want to install SQL Server 2014 Express as part of the Supply Chain Guru installation.
- You have a version of ArcGIS Engine Runtime other than 10.0.4400 installed and you want to upgrade to the required version for Supply Chain Guru 8.2.
- You are upgrading from an earlier version of Supply Chain Guru.

4. After the download completes, right-click the file you just copied and select the “Run as administrator” option to start the installation process. The install center first extracts all files, which may take a few minutes. When the install center indicates the components that will be installed, ArcGIS Engine Runtime 10.0.4400 (if not installed already), SQL Server 2014 Express (if on Windows 7 or Windows 8 and not already installed) and Supply Chain Guru 8.2, click the **Install** button to start installing the applications. This may take up to 30 minutes for installation of all applications.

**Note:** If you are installing on Windows 8 or Windows 8.1, you may be prompted to install the Microsoft .NET Framework 3.5. Follow the instructions to install this component, then restart the Supply Chain Guru installer.

During the installation, use the **Next** button to click through installation wizard screens. By default, Supply Chain Guru 8.2 is installed in the Supply Chain Guru folder. To install Supply Chain Guru 8.2 in a different folder, change the installation path.

5. If the Install Center installs SQL Server 2014 to your computer, at the conclusion of the installation, you will be prompted to reboot your computer. LLamasoft recommends that you reboot the computer to successfully complete the SQL Server installation.

6. If you already had Supply Chain Guru installed on your computer, your existing license should work with the updated version of Supply Chain Guru. If this is a new installation of Supply Chain Guru, apply the license file you received from LLamasoft.
Note: If a problem occurs when applying the license, you will see a message indicating there has been a problem. Please contact our License Manager at Licensing@LLamasoft.com if you have any problems with your license.

Refer to “Supply Chain Guru Licensing” on page 52 for additional information about the Supply Chain Guru licensing system.

7. To allow Bing basemaps to be displayed in Supply Chain Guru, you must run the Set Bing Key utility for ArcGIS:
   - On machines with a 64-bit operating system, select Set Bing Key from the Supply Chain Guru start menu. You see the Set Bing Key form.
   - On machines with a 32-bit operating system, using File Explorer, navigate to the C:\Program Files\ArcGIS\Engine10.0\bin folder, then double-click on SetBingKey.exe. You see the Set Bing Key form.
   - Copy and paste the Bing Account Key provided by LLamasoft
   - Click OK.

After Installation

When you first start Supply Chain Guru, if the application detects that the .NET Framework 4.5.1 is not currently installed, you will be prompted to install it. Once this installation is complete, Supply Chain Guru will run successfully.

It is recommended that you check the About Guru screen in Supply Chain Guru 8.2. The screen should appear as shown in the following image, and you should not see any question marks on the screen:

Supply Chain Guru Version 8.2 About Screen:
Uninstalling Supply Chain Guru

When uninstalling Supply Chain Guru and the related software, LLamasoft recommends the following procedure.

Note: Uninstalling SQL Server (2008 R2 or 2014) and ArcGIS Engine Runtime 10 is not required when uninstalling Supply Chain Guru. However, if you are uninstalling these products, the order in which they are uninstalled is important.

Uninstall Supply Chain Guru
1. Select Start > Control Panel > Programs & Features or Uninstall a program.
2. Select Supply Chain Guru.
3. Click Uninstall.
4. Follow the uninstall process for Supply Chain Guru.

Uninstall SQL Server
1. Select Start > Control Panel > Programs & Features or Uninstall a program.
2. Select Microsoft SQL Server 2008 R2 or Microsoft SQL Server 2014, depending on the version currently installed.
3. Click Uninstall/Change.
4. Follow the uninstall process for SQL Server, selecting the Remove option.

Uninstall ArcGIS Engine Runtime 10
1. Select Start > Control Panel > Programs & Features or Uninstall a program.
3. Click Uninstall/Change.
4. Follow the uninstall process for ArcGIS Engine Runtime 10, selecting the Remove option.

Delete Program Folders
1. Navigate to C:\Program Files (x86)\ArcGIS\ESRI\Supply Chain Guru
2. Delete the following folders, if present:
   - ArcGIS
   - ESRI
   - Supply Chain Guru

Empty Recycling Bin
1. Right-click on Recycle Bin.
2. Select Empty Recycle Bin.

Reboot Computer
Supply Chain Guru Licensing

Supply Chain Guru uses a flexible licensing system. This license manager provides licensing options such as floating and roaming licenses. The specific licenses you have available to you depend upon your agreement with LLamasoft, Inc.

**Standard Licenses**

If you have a standalone license on your computer, you will use a standard license. This license is installed on your computer and will determine which of the available components of Supply Chain Guru are active on your computer:

- Network Optimization
- Inventory Optimization
- Simulation
- Vehicle Route Optimization

There are several ways in which you register Supply Chain Guru and activate your license:

- **Internet Activation using Authorization Code**
- **Update Licenses from File**
- **Request License via Email**

**Internet Activation using Authorization Code**

When you use this method to activate your license, you must first obtain an authorization code from LLamasoft.

**To activate your license with an authorization code:**
1. Obtain an authorization code from LLamasoft.
2. Run Supply Chain Guru.
3. Select **File > Admin > Licensing**.
4. Select **Internet Activation using Authorization Code**.
5. Enter the code you received in the Authentication Code field and click **Submit**.

**Update Licenses from File**

You will typically use this type of license activation to enable additional functionality in Supply Chain Guru. When you use this method to activate your license, you must first obtain a license file from LLamasoft.

**To activate your license with an authorization code:**
1. Obtain a license file from LLamasoft and copy this file to your computer. The file can be located in any folder.
2. Run Supply Chain Guru.
3. Select **File > Admin > Licensing**.
4. Select **Update Licenses from File**.
5. Click the browse button and navigate to the folder where you copied the license file from LLamasoft.
6. Select the file and click **Open**, then click **Submit**.
Request License via Email

To request a license via email:
1. Run Supply Chain Guru.
2. Select File > Admin > Licensing.
3. Select Request License via Email.
4. Provide the requested information:
   - First Name
   - Last Name
   - Institution
   - Email
   - Phone
5. Click Next. You see a window with system information that you must supply to LLamasoft.
6. Click Send. This copies the information into a new email message using your email provider. The message will be sent to licensing@llamasoft.com.

You will receive a license file or authentication code from LLamasoft.

Floating and Roaming Licenses

In addition to named user licenses, LLamasoft also offers a licensing option for floating and roaming licenses. For both floating and roaming licenses, a pool of licenses is kept on a computer called the license server. Client computers running Supply Chain Guru can check out licenses from this pool until all licenses are checked out. If all licenses are checked out, a request for a license by an additional Supply Chain Guru computer will be denied and Supply Chain Guru will not open on this client computer.

- Floating License - The user can check out a license for an indefinite period. The client computer must be on the network and have access to the license server computer at all times in order to be able to check out licenses.
- Roaming License - The user can check out a license for a specified number of days. The client computer must be on the network and have access to the license server computer to initially check out the license. Once roaming has started, the user can disconnect from the network and the license will continue to work until the number of roaming days has expired. At that point, Supply Chain Guru will stop working and the license is automatically returned to the license pool. The user must connect to the network in order to check out a license again.

To initiate roaming:
a. Start Supply Chain Guru.
b. Select About Guru > Start Roaming. If a roaming license is available, it is deployed to your computer for the default roaming period established for your organization. When you start next start Supply Chain Guru, you see a message indicating how many days remain before your roaming license is set to expire.

To end roaming:
a. Start Supply Chain Guru.
b. Select About Guru > Stop Roaming. The roaming license is returned for use by another Supply Chain Guru user.
Please contact your LLamasoft representative or send an e-mail to sales@llamasoft.com if you are interested in learning more about this licensing option.

**Default Licenses**

Supply Chain Guru licensing supports a default license. The default license that comes with Supply Chain Guru is a 45-day license, and supports a limited number of sites (100) and products (10). Once a computer has had a default license, installing Supply Chain Guru on it again will not activate another 45 day license. Instead, the user will have the option to register to request a new license.

**Limited License**

LLamasoft can also provide a limited license. It has the same limits on sites and products as the default license, but can be set with a different expiration period.

**Connecting to Remote Design Engines**

If you want to send models to the remote design engines, you should verify your connection.

To use Supply Chain Guru 8.2.x with remote design engines, the URL is:

http://supplychainguru.com
1. With Supply Chain Guru open, click on the File tab, then click Application Settings.

2. Select the Cloud tab.

3. Enter your Supply Chain Guru URL.
   - Current Release: http://supplychainguru.com – This will be the default value if this is a brand new installation.
   - Supply Chain Guru 8.1.x: http://k2-scg81.supplychainguru.com – This will be the default value if a previous version of Supply Chain Guru was on the machine.

Note: The current release will be the generally available customer release of Supply Chain Guru. When a new release is made available, LLamasoft will keep the Current Release url set to the previous release for a short time to enable users to update as needed.

4. Enter your supplychainguru.com User name Password to connect.
5. Click **Connect** to test your connection. Verify that your **Connection Status** is **Valid** and your **Connection Quality** is **Very Good**.

6. Click **Apply**, then click **OK**.

**Connecting to K2 Enterprise**

If you are working with K2 Enterprise, you should verify your connection to the K2 Enterprise server.

1. With Supply Chain Guru open, click on the **File** tab, then click **Application Settings**.

2. Select the **K2 Enterprise** tab.

3. Enter your **Supply Chain Guru URL**.

4. Set up your Supply Chain Guru credentials:
   - If you are using Windows Authentication, select **Use Windows Authentication**.
If you are not using Windows Authentication, leave the **Use Windows Authentication** option unchecked. Enter your **User Name** and **Password**.

5. Click **Connect** to test your connection. Verify that your **Connection Status** is **Valid** and your **Connection Quality** is **Very Good**.

6. Click **Apply**, then click **OK**.

**Web Services Information**

Your IT department can allow the User Agent Strings, Hosts, and URLs of the http headers that Supply Chain Guru uses when calling web services as exceptions in your proxy server script or proxy server settings. Note that you do not need to use all 3 methods; your company can choose the method it is most comfortable with.

**Note:** You should not set proxy server settings for Bing or Google web services. This can prevent these services from working.
If these features currently work with no problem, no further action is required by the Supply Chain Guru user or by the IT department.

This website provides some examples on how proxy scripts can be set up to allow for these type of exceptions:

## User Agents

<table>
<thead>
<tr>
<th>SCG Actions</th>
<th>User-Agent Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geocoding or Distance Calculations with Esri providers</td>
<td>Mozilla/4.0 (compatible; MSIE 6.0; MS Web Services Client Protocol 2.0.50727.XXXX)</td>
</tr>
<tr>
<td>Geocoding or Distance Calculations with Bing provider</td>
<td>no user agent identified (WCF service vs. web ASP.net web service)</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>ArcGIS URI Download Build 10.0.0.2414</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>ArcGIS Single Signon</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>ArcGIS Bing URI</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>ArcGIS Client Using WinInet</td>
</tr>
<tr>
<td>Rateware XL lookups</td>
<td>Mozilla/4.0 (compatible; MSIE 6.0; MS Web Services Client Protocol 2.0.50727.XXXX)</td>
</tr>
<tr>
<td>SCG installation</td>
<td>Microsoft-CryptoAPI/5.131.2600.5512</td>
</tr>
<tr>
<td>SCG Web-Update</td>
<td>Wise</td>
</tr>
<tr>
<td>SCG Web-Update</td>
<td>Windows Installer</td>
</tr>
</tbody>
</table>

## Hosts

<table>
<thead>
<tr>
<th>SCG Actions</th>
<th>Host</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geocoding or Distance Calculations with Esri providers</td>
<td>tasks.arcgisonline.com</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td><a href="http://www.arcgis.com">www.arcgis.com</a></td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>serverapi.arcgisonline.com</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>t0.tiles.virtualearth.net</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>t1.tiles.virtualearth.net</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>t2.tiles.virtualearth.net</td>
</tr>
<tr>
<td>Web-based Maps</td>
<td>t3.tiles.virtualearth.net</td>
</tr>
<tr>
<td>Rateware XL lookups</td>
<td>demo.smc3.com</td>
</tr>
<tr>
<td>SCG installation</td>
<td>crl.verisign.com</td>
</tr>
<tr>
<td>SCG installation</td>
<td>directly at beginning when starting on ESRI GIS Software</td>
</tr>
<tr>
<td>SCG installation</td>
<td>csc3-2009-2-crl.verisign.com</td>
</tr>
<tr>
<td>SCG installation</td>
<td>directly at beginning when starting on ESRI GIS Software</td>
</tr>
<tr>
<td>SCG Web-Update</td>
<td><a href="http://www.llamasoft.com">www.llamasoft.com</a></td>
</tr>
</tbody>
</table>
## URLs

<table>
<thead>
<tr>
<th>SCG Actions</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>K2 Cloud connection</td>
<td>k2-scg80.supplychainguru.com</td>
</tr>
<tr>
<td></td>
<td>IP 64.9.219.200</td>
</tr>
<tr>
<td>K2 Cloud connection</td>
<td>k2-scg80.supplychainguru.llamasoft.com</td>
</tr>
<tr>
<td></td>
<td>IP 64.9.219.193</td>
</tr>
<tr>
<td>Esri NA geocoding</td>
<td><a href="http://tasks.arcgisonline.com/ArcGIS/services/Locators/TA_Address_NA_10/GeocodeServer">http://tasks.arcgisonline.com/ArcGIS/services/Locators/TA_Address_NA_10/GeocodeServer</a></td>
</tr>
<tr>
<td>Esri EU Geocoding</td>
<td><a href="http://tasks.arcgisonline.com/ArcGIS/services/Locators/TA_Address_EU/GeocodeServer">http://tasks.arcgisonline.com/ArcGIS/services/Locators/TA_Address_EU/GeocodeServer</a></td>
</tr>
<tr>
<td>Esri World Geocoding</td>
<td><a href="http://tasks.arcgisonline.com/ArcGIS/services/Locators/ESRI_Places_World/GeocodeServer">http://tasks.arcgisonline.com/ArcGIS/services/Locators/ESRI_Places_World/GeocodeServer</a></td>
</tr>
<tr>
<td>Esri NA Routing</td>
<td><a href="http://tasks.arcgisonline.com/ArcGIS/services/NetworkAnalysis/ESRI_Route_NA/mapserver/NAServer">http://tasks.arcgisonline.com/ArcGIS/services/NetworkAnalysis/ESRI_Route_NA/mapserver/NAServer</a></td>
</tr>
<tr>
<td>Esri EU Routing</td>
<td><a href="http://tasks.arcgisonline.com/ArcGIS/services/NetworkAnalysis/ESRI_Route_EU/mapserver/NAServer">http://tasks.arcgisonline.com/ArcGIS/services/NetworkAnalysis/ESRI_Route_EU/mapserver/NAServer</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://www.arcgis.com/arcgisuris.xml">http://www.arcgis.com/arcgisuris.xml</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://serverapi.arcgisonline.com/veadaptor/production//services/identity/clientip">http://serverapi.arcgisonline.com/veadaptor/production//services/identity/clientip</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=Road">http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=Road</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=Aerial">http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=Aerial</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=AerialWithLabels">http://serverapi.arcgisonline.com/veadaptor/production//services/imagery/getmetadata?token=AleG3-ooLYAIGSuWGVAC4P_e4U_zPe-6zt1KqpoKMt42z6FgSieHvJHhNkQ1f1&amp;style=AerialWithLabels</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services">http://services.arcgisonline.com/ArcGIS/services</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/arcgis/services">http://services.arcgisonline.com/arcgis/services</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Terrain_Base/MapServer">http://services.arcgisonline.com/ArcGIS/services/World_Terrain_Base/MapServer</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer">http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=0&amp;column=1&amp;format=JPEG">http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=0&amp;column=1&amp;format=JPEG</a></td>
</tr>
<tr>
<td>SCG Actions</td>
<td>URL</td>
</tr>
<tr>
<td>-------------</td>
<td>-----</td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=0&amp;column=0&amp;format=JPEG">http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=0&amp;column=0&amp;format=JPEG</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=1&amp;column=0&amp;format=JPEG">http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=1&amp;column=0&amp;format=JPEG</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=1&amp;column=1&amp;format=JPEG">http://services.arcgisonline.com/ArcGIS/services/World_Shaded_Relief/MapServer?mapname=Layers&amp;layer=_alllayers&amp;level=1&amp;row=1&amp;column=1&amp;format=JPEG</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://a.tile.openstreetmap.org/1/0/0.png">http://a.tile.openstreetmap.org/1/0/0.png</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://a.tile.openstreetmap.org/1/1/0.png">http://a.tile.openstreetmap.org/1/1/0.png</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://a.tile.openstreetmap.org/1/1/1.png">http://a.tile.openstreetmap.org/1/1/1.png</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://a.tile.openstreetmap.org/1/1/0.png">http://a.tile.openstreetmap.org/1/1/0.png</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/r3.jpeg?g=761&amp;mkt=en-US&amp;shading=hill&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/r3.jpeg?g=761&amp;mkt=en-US&amp;shading=hill&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/r0.jpeg?g=761&amp;mkt=en-US&amp;shading=hill&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/r0.jpeg?g=761&amp;mkt=en-US&amp;shading=hill&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/a0.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/a0.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/a2.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/a2.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/a3.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/a3.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Web Maps</td>
<td><a href="http://t0.tiles.virtualearth.net/tiles/a1.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1">http://t0.tiles.virtualearth.net/tiles/a1.jpeg?g=761&amp;mkt=en-US&amp;token=AleG3-ooLyYAIGSuWGVAC4P_e4U_zPe-6ztIKYqpoKMt42z6FgSieHvJHhNkQ1f1</a></td>
</tr>
<tr>
<td>Install</td>
<td><a href="http://crl.verisign.com/pca3.crl">http://crl.verisign.com/pca3.crl</a></td>
</tr>
<tr>
<td>SCG Actions</td>
<td>URL</td>
</tr>
<tr>
<td>-------------</td>
<td>-----</td>
</tr>
<tr>
<td>Web-update</td>
<td>other SCGWebXXX.cab numbers in future web-updates</td>
</tr>
<tr>
<td>RateWare XL</td>
<td>/AdminManager/services/RateWareXL</td>
</tr>
</tbody>
</table>
Index

Symbols
.NET Framework 40

A
activating 46

B
Bing Geocoding Service 46
Bing Maps 46
temporary license key 47

G
Google Earth 46

H
hardware requirements 39
hardware requirements 37

M
memory requirements 39
Microsoft SQL Server 41
model sizing 39

O
Operating System 38, 40

P
prerequisite software 40

R
RateWare XL 47
remote hosts 40
requirements 37
hardware 37, 39
memory 39
software 40

S
sizing 39
SQL Server 41
system requirements 37

T
Tableau 47

U
user agents 40